12d Stormwater Design
Part 1

Version 10.0

Revised April 2013

V10.0 - April 2013

Disclaimer

12d Model is supplied without any express or implied warranties whatsoever.
No warranty of fitness for a particular purpose is offered.
No liabilities in respect of engineering details and quantities produced by 12d Model are accepted.
While every effort has been taken to ensure that the advice given in this manual and the program 12d Model is correct, no warranty is expressed or implied by 12d Solutions Pty Ltd.

Copyright

This manual is copyrighted and all rights reserved.
This manual may not, in whole or part, be copied or reproduced without the prior consent in writing from 12d Solutions Pty Ltd.
Copies of 12d Model software must not be released to any party, or used for bureau applications without the written permission of 12d Solutions Pty Ltd.

Copyright © 1989 – 2013 by 12d Solutions Pty Ltd.
Sydney, New South Wales, Australia.
ACN 101 351 991
All rights reserved.
### 1.0 12d Model Drainage Modules and Work Flow

1.1 Drainage Module ................................................................. 5
1.2 Drainage Analysis Module .................................................. 5
1.3 Dynamic Drainage Module - Unsteady flow analysis ................ 6
1.4 TUFLOW and Roadflow Modules ........................................ 6

### 2.0 12d Model Stormwater Courses

2.1 Stormwater Design Part 1 ................................. 7
2.2 Stormwater Design - Part2 .............................................. 7
2.3 Stormwater Basin Design Hydraulics and Hydrology ............... 7

### 3.0 Using the Course Notes

3.0 Using the Course Notes ................................................................ 8

### 4.0 Customising 12d Model Drainage

4.1 Stormwater Design Part 1 ................................................... 7
4.2 12d Model Stormwater Courses ......................................... 7
4.3 Stormwater Basin Design Hydraulics and Hydrology ............... 7

### 5.0 Survey data and design surfaces (TINs)

5.1 Importing the Raw Survey Data ........................................... 11
5.2 Creating the existing Ground Surface ................................. 12
5.3 Viewing the Ground Surface Tin ......................................... 13
5.4 Inquiring about Heights on the Surface ............................... 15
5.5 Viewing the Surface Tin in a 3d Perspective ......................... 16
5.6 Reducing the number of points for the 12d Practice Version ...... 16
5.7 Importing the Road Design Centre lines ............................. 16
5.8 Using Create Roads ............................................................. 17
5.9 Creating a Super Tin from the Survey and Design Data ............ 19
5.10 Changing the Colour of a Tin ............................................. 19

### 6.0 Drainage Overland Flow Investigation

6.0 Drainage Overland Flow Investigation ............................... 21
6.1 Downhill Strings ................................................................. 21
6.2 Locating Crests and Sag Points ........................................... 21
6.3 Creating a Filter Favourite .................................................. 24
6.4 Rain drop .......................................................................... 24

### 7.0 Setting Drainage Defaults (Initial Settings)

7.0 Setting Drainage Defaults (Initial Settings) ......................... 25
7.1 Tin Default ......................................................................... 25
7.2 Manhole (Pit) Defaults ...................................................... 25
7.3 Pipe Defaults ..................................................................... 26
7.4 String Colour and pit Label Text Size/location (string defaults) 27

### 8.0 Creating Drainage Strings

8.0 Creating Drainage Strings ................................................... 29
8.1 Read in a drainage model template ..................................... 29
8.2 Creating the Drainage Strings in 12d ................................. 29
8.3 Change Pit and Pipe Types and Sizes ............................... 31
8.4 Flow in the Wrong Direction ............................................. 33

### 9.0 Drainage Strings Levels

9.0 Drainage Strings Levels ..................................................... 34
9.1 Pit Levels ......................................................................... 34
9.2 Pipe Levels ...................................................................... 34
9.3 Section View of a Drainage String .................................... 34
9.4 Set Pit Details ................................................................. 35
9.5 Regrade Pipes ............................................................... 36
9.6 Setout Strings to Align the Headwalls with the Roadway ...... 37
9.7 Adjust Pipe Length ........................................................... 38

### 10.0 Importing Drainage Layouts from AutoCAD

10.0 Importing Drainage Layouts from AutoCAD ...................... 40
10.1 Checking the String Direction of CAD Network Strings ...... 40
10.2 Create the drainage strings from the CAD strings ............... 41

### 11.0 Horizontal Alignment and Drainage String Edits

11.0 Horizontal Alignment and Drainage String Edits ............... 43
11.1 Road design strings (centre line) for Adjust Pit Locations ...... 43
11.2 Log Lines with the Drainage Network Editor .................... 44
11.3 Adjust Pit Locations ........................................................ 46
11.4 Manual Horizontal Alignment - Moving, Adding and Deleting Pits 47

### 12.0 Completing the Intersection Drainage Design

12.0 Completing the Intersection Drainage Design .................... 48
12.1 Placing Marker Points around the Intersection ......................................................... 48
12.2 Option 1 (Connection at Manhole in the Road) ......................................................... 48
12.3 Option 2 (Connection pipe under the footpath) ......................................................... 49
12.4 Intersection Check List ............................................................................................ 49
12.5 Offsets from strings ................................................................................................. 50
12.6 Placing pits at specific Easting Northing Locations .................................................. 50

13.0 Manholes - A Closer Look ....................................................................................... 51
13.1 Pit-Pipe Connection Points ....................................................................................... 51
13.1.1 Pit Connection Point Modes ................................................................................. 52
13.2 Junction Pits ............................................................................................................ 53
13.3 Drainage Section Views (downhill left to right OR right to left) ................................. 54
13.4 Drainage Split and Join .......................................................................................... 55

14.0 Drainage Network Editor (DNE) ........................................................................... 56
14.1 Update from drainage 4d ......................................................................................... 57
14.2 Moving through the Drainage Network .................................................................. 58
14.3 Auto-Apply, Auto-Pan, Auto-Profile and Auto-Redraw ............................................. 58
14.4 Set Pit names (and pipes) ....................................................................................... 58
14.5 Set Pit Names using Pit Type .................................................................................. 59
14.6 Change Pit Name Textstyle and Offset ..................................................................... 61

15.0 Vertical Alignment - Manholes ............................................................................... 63
15.1 Cover RL, Grate RL, Setout RL and Sump RL modes ................................................. 63

16.0 Vertical Alignment - Pipes ....................................................................................... 65
16.1 Minimum Cover .................................................................................................... 65
16.2 Minimum Grade ..................................................................................................... 65
16.3 Pipe Grade Modes ................................................................................................. 66
16.4 Downstream Alignment Modes ............................................................................... 66

17.0 Service and Utility Clashes ..................................................................................... 69

18.0 Drainage Plan Plots ................................................................................................ 73
18.1 Labelling the Pits and Pipes ................................................................................... 73
18.1.1 Turn off View Text Pit Labels ............................................................................. 74
18.1.2 Moving Text ....................................................................................................... 75

19.0 Construction Setout ................................................................................................ 77
19.1 Pit Setout (xy) ......................................................................................................... 78
19.2 Pit Setout (z) Level .................................................................................................. 78
19.3 Road Centre Line Chainage .................................................................................... 78
19.4 Pipe Setout ............................................................................................................. 78
19.5 Plan Plots for Surveyors ......................................................................................... 79
19.6 Construction Manhole/Pit Schedules ..................................................................... 79

20.0 DNE and Rational Hydrology ................................................................................ 82
20.1 Network Editor - Global, Default Settings and Explicit Settings .............................. 82
20.1.1 Catchment Areas and Percent Impervious ......................................................... 82
20.1.2 Coefficients of Runoff ....................................................................................... 83
20.1.3 Times of Concentration ..................................................................................... 84
20.2 Catchment Areas .................................................................................................. 84
20.3 Drawing Catchment Strings in 12d ......................................................................... 87
20.4 Splitting Catchment Strings to Insert an Inlet ......................................................... 89
20.5 Tc Path Strings ..................................................................................................... 91
20.5.1 Catchment slope (equal area) .......................................................................... 92

21.0 Network Editor - Hydraulics .................................................................................. 94
21.1 Grate Levels .......................................................................................................... 94
21.2 Outlet and Tailwater Conditions ............................................................................ 94
21.3 Culvert Hydraulics and Tailwater ........................................................................... 94
21.4 Pit Losses Ku, and Direct Flow ............................................................................. 95
21.5 Introduction to 12d Ku/Kw Calculations .................................................................. 96
21.6 Pipe Friction Method, Roughness Values and Direct pipe flow ............................. 97
21.7 Design mode, Freeboard Limit and Flow-depth limit ......................................................... 97
21.8 Pipe Design Parameters - Sizes, Invert alignment, Min Cover, Max Height ...................... 98
21.9 Pipe sizes, Max pipe height and Multiple Pipes and Box Culverts .................................... 98
21.10 Pipe Size Design ................................................................................................................... 99
21.11 Calculate Bypass flow routes .............................................................................................. 99

22.0 Drainage Design in 12d Drainage Design .......................................................................... 100
22.1 12d Rational Method Hydrology - Drainage Rainfall Editor ............................................. 100
   22.1.1 IFD Tables ...................................................................................................................... 100
   22.1.2 Australian Rainfall and Runoff 1987 Method ................................................................. 101
   22.1.3 Australian Rainfall and Runoff 1977 Method ................................................................. 102
22.2 Drainage Network Design ................................................................................................. 102
22.3 Pipe Sizes too Large? .............................................................................................................. 104
22.4 The Run Button and HGL data on the Section View ......................................................... 105
22.5 Importing Text into a 12d model ......................................................................................... 105
   22.5.1 Design Results ............................................................................................................. 107

23.0 Create a Drainage Model Template (Saving Defaults and Globals) ................................. 110

24.0 Drainage Data Input and Output to Spreadsheets .............................................................. 111
24.1 12d to spreadsheet transfers ............................................................................................... 111

25.0 Long Section Plotting .......................................................................................................... 112

26.0 More Information .................................................................................................................. 115
26.1 Linking to Strings in General .............................................................................................. 115
26.2 Catchment string links ......................................................................................................... 115
26.3 Road string links ............................................................................................................... 115
26.4 Bypass string links .............................................................................................................. 115

27.0 Training Check List ............................................................................................................. 116
1.12d Model Drainage Modules and Work Flow

12d Model has a suite of drainage modules for stormwater design. This course covers the items listed below on this page except 24, 25 and 28.

Part A - Locate Structures and Connect the Pipe Network
1. Obtain/create Survey data and design surfaces (TINs) for pipe and manhole levels,
2. Identify overland flow paths and drainage inlet structure locations,
3. Set drainage default for the pits and pipes (most common settings, they may be changed later).
4. Read a drainage model template file containing you default and global settings.
5. Create the drainage strings in 12d or convert strings from CAD.
6. Assign pit names using the DNE. This allows easy reference to the structures.
7. Change pit and pipe types where they are different from the default values
8. Link the drainage model to the road design models for an integrated design.
9. Check and adjust horizontal alignment of the pipes and pits.
10. Set the vertical alignment using the DNE (set pit details and regrade pipes).
11. Check for service clashes and adjust vertical as required.

Part B - Hydrology and Hydraulic Data Preparation
12. Set catchment areas, % impervious, C and tc values for hydrology,
13. Set grate levels, Ku methods (pit and culverts), pipe roughness etc for hydraulic design
14. Draw/create bypass flow paths if bypass/inlet capacity calcs are required.
15. user defined export and update interfaces with Drains, PCdrain, Micro drainage-WinDes, RAT2000 and XP SWMM/STORM.

Part C - Design Documentation
16. Print pit schedules and plan/long section drawings for construction,
17. Import and Export the network to spreadsheets,
18. Calculate network quantities (by depth ranges) for costing and system checks,
19. Calculate earthwork excavation volumes,
20. Repeat as required for design changes,
21. And of course peer review at various points of design,
22. Electronic models for survey setout.

1.2 Drainage Analysis Module

Part D - Rational Hydrology, Surface Flow Calculations and Pipe Hydraulics
23. Calculate rational hydrology peak discharges,
24. Normal depth surface flow hydraulics using channel sections cut from the ground surface. Results are shown in plan, section and 3d views (and reports) with warnings given for exceeding max widths, channel capacity and velocity x depth hazard conditions,
25. inlet capacities at sag and on grade locations determine bypass and pipe flows,
26. Hgl calculations use pipe and manhole losses (Ku/Kw). Pipe are sized using either freeboard or flow depth methods. This includes full culvert design with backwater and inlet control calculations.

27. Review results in plan drawings, long sections and printed reports,

28. Analysis of the major flood event and checks for surface flow and hazard conditions.

1.3 Dynamic Drainage Module - Unsteady flow analysis

This module uses ILSAX and SCS hydrology together with the solution of the unsteady flow equations to analyse the network. Inlet capacity charts are used to analyse surface and subsurface hgl lines. Natural channel shapes and elevation-area curves for basin are created directly from the ground surface. User defined reports are created via the spreadsheet interface.

1.4 TUFLOW and Roadflow Modules

These modules use the TUFLOW engine (1D/2D hydrodynamic computational engine) for simulating free-surface water flow for urban waterways, rivers, floodplains, estuaries and coastlines. Using tools including 12d grid tins and the 12d TUFLOW control file editor the 12d, TUFLOW input data is created, edited and viewed all within 12d. This module may be combined with the dynamic drainage module for a coupled 1D/2D analysis to include pipes and culverts.
2.1.2d Model Stormwater Courses

In these documents, the generic term pit refers to manholes, inlets and catch basins. When the term manhole is used on the 12d menu system it refers to any type of pit.

2.1 Stormwater Design Part 1

These notes are for this course designed to cover creating drainage networks, rational method design and reporting.

- create a super tin for pipe cover and pit cover levels,
- set Defaults and layout a drainage network from CAD and in 12d,
- use the 12d Drainage Network Editor to assign names to the pit/pipes, avoid service clashes, grade pipes, align obverts, minimise depth and many other design tools,
- designate catchment areas and produce catchment plans,
- run the 12d storm rational hydrology and hydraulics engine,
- transfer data to and from electronic spreadsheets to enable the user to easily review the data and add user defined data to the 12d pipe network. This data may include such data as pipe bedding types and trench width,
- create a drainage template containing customised default design parameters,
- create pit setout schedules to export to spreadsheets or word processors for final formatting,
- produce long section drainage profiles including HGL data, flows, invert levels and service crossings,
- create plan drawings with pipe sizes, flows, pit symbols, linestyles for pipe sizes, design parameters for pit and pipes and user defined data,
- locate pits/manholes at exact chainage and offset locations.

2.2 Stormwater Design - Part2

This course continues on with surface flow analysis, inlet capacity and bypass flow and customising the 12d drainage setup file (pit and pipe type database).

- customising the drainage.4d file Drainage Definitions - Manholes and Pipes,
- 12d storm analysis with inlet capacity calculations and bypass flow,
- flooded width analysis and flooding at SAG pits,
- drainage trench excavation volume calculations,
- pipe and pit quantity calculations/reports,
- open channel calculations,
- adjusting pit locations for changes in horiz road geometry
- analysing the major flood events,
- creating drainage symbols with grates and upstream side inlets,
- detailed drainage plan labelling and long sections with hatching under roads.

2.3 Stormwater Basin Design Hydraulics and Hydrology

- The course discusses unsteady flow hydraulics and their use in the design of storage basins and tanks.
3. Using the Course Notes

Areas marked in yellow (grey for black and white prints) are the exact steps required to complete the tasks. The numbers in the panels are the order to preform the tasks and they are always written to the right of the button, drop down or data field.

The additional text explains in more detail the tasks you are preforming.
4. Customising 12d Model Drainage

12d Drainage has a series of files that customise your drainage components and design process. These include:

- **drainage.4d (required)**
  - Manhole types and properties
  - Pipe types and properties

- **drainage model template**
  - Contains global and default settings for the drainage network. Including references to the following files.

- **cover files**
  - Specify pipe cover for each pipe type

- **grade file**
  - Specify pipe/channel slope by height

- **drop file**
  - Specify drop across manholes by deflection angle

- **catchment file**
  - Specify polygons for 3 land use types

- **road design file**
  - Link manholes to strings to determine x,y,z coordinates

- **services file**
  - Specify clearance tolerances for models of service crossing.

The drainage.4d file has been configured for the training version. However, when you start working on your projects you may want to customise the drainage module. More - Customising the drainage module.

The drainage.4d file is the required drainage setup file that contains:

- Manhole and inlets with wall thickness and inlet capacity curves for ongrade and sag conditions
- Pipe types (RCP, Class 2 etc.) with nominal pipe diameters and wall thicknesses,
- User defined attributes lists to be assigned to the network via pit and pipe types.
- Manhole and pipe type parameters are used to control settings in the DNE. This allows the user to set numerous properties by selecting only the pit or pipe type. More.
5. Survey data and design surfaces (TINs)

We will start a 12d project from the beginning by first creating the project and then reading in the survey and design data. The data can then be triangulated so that we have a final surface to measure pipe cover from and set structure cover levels to.

Start up the 12d model by selecting the 12d icon from your desktop.

The project selection panel will appear. The bottom corner of the panel is shown below.

1) LB to browse to the working folder indicated.
2) Type a project name for your work Stormwater Part 1 all for example.
3) Select Proceed.

Alternate Step 2. If you do not want to create the tin or roadway then select the existing project Stormwater Part1 found in the courses\drainage folder. Skip to the section Drainage Overland Flow Investigation or go straight to Read in a drainage model template.

12d will first look in your working folder for any input data files and output files will be created here unless you specify another folder. 12d stores it’s data in a folder not a single file. Therefore, a folder named Stormwater Part 1 all will be created when you select Proceed.

12d model will load and you will see the following panel.
5.1 Importing the Raw Survey Data

You have created a new project into which we will import the survey data. From the main menu select:

File I/O->Data Input->12da/4da data

1) LB the folder icon to display the file list. Select the file *existing survey.*
2) LB Read to read the data
3) LB Finish to remove the panel

The data will appear on a new plan view.
5.2 Creating the existing Ground Surface

From the main menu select

\[ \text{Tins} \Rightarrow \text{Create} \Rightarrow \text{Triangulate data} \]

Now we will display the z values for the survey data.

1) LB the toggle button
2) LB Z values

Use your mouse wheel to zoom in and read the z values. Press Ctrl and Middle mouse drag to pan

1) Type a name for the function to make it easy to recalculate later in new data arrives.
2) Type a new tin name then press Enter
3) Type grass2 instead of green. This will look better in the visualisation.
4) LB Remove Bubbles so that breaklines will attempt not to form triangles back onto themselves (if the breakline is a contour, this removes contour bubbles).

\text{Preserve strings} will make one side of a triangle follow the string thereby preserving the levels along the string.

\text{Weed tin} removes all duplicate points from the tin database.

The \text{Cell method} is a good speed enhancement for data that is in a grid type pattern.

\text{Triangle data} is used for string that form triangles (tins imported from other programs).
5.3 Viewing the Ground Surface Tin

The tin will be shown with the tin edges turned on. This is the default when you have all tin display modes turned off.
Display Contours
1) LB the toggle button
2) LB Tin contours.

The contours are displayed with their default colours and increment (1 unit).

Display Flow
1. LB the toggle button
2. LB Tin flow.
Flow arrows are now visible at the centre of every triangle.

To plot flow arrows, create them in a model using Tins->Tin analysis->Flow arrows

Change Contour Intervals and Colours
1) LB the View menu button
2) Walk right (do not LB select) on settings.
3) Walk right on Tins.
4) LB Contours

4) LB Contours

Shortcut! Press F11 to display the Menu shown in step 4
Change the Flow Arrow Length and Colour

Select the **Menu** button on the **plan view tool bar** and then walk right on.

Settings=>$Tins=>$Flow Arrows and the following dialog will appear. Remember to walk right!

5.4 Inquiring about Heights on the Surface

The elevation anywhere on the tin can be obtained by simply moving the pointer over the desired spot. To obtain the tin elevations select,

1) Type a new **Cont inc**
2) Type a new **Bold inc**.
3) LB **Set** to see the new contours.
4) LB **Finish** when done.

If you do not select a tin, the last tin added to the view will have its height displayed. You will see the data
in the panel change as you move the pointer around the screen. You may explicitly select a tin if another tin is desired.

Move the panel to the bottom right corner of the screen and leave it there.

5.5 Viewing the Surface Tin in a 3d Perspective

To create a 3d perspective view select

View=>New=>Perspective Open GL

1) Add the model **tin existing** to the view.
2) **Toggle** the **contours** on.
3) **Toggle** the **shading** on (note that the contours are no longer seen).
4) Use the Orbit control (planet on the toolbar) and zoom wheel to move around the view.

5.6 Reducing the number of points for the 12d Practice Version

We can delete the survey data to save space for those using the practice version of 12d. If you have a full version of 12d this is not required. From the main menu select.

Models=>Delete=>Delete a Model

and the following dialog will appear.

1) LB the icon and select **EXISTING SURVEY**
2) LB **Delete** and then confirm each panel
3) LB **Finish**

The model is now in the 12d trash can (see bottom right corner of the 12d screen).

5.7 Importing the Road Design Centre lines

Repeat the process of importing 12da data.

File I/O->Data Input->12da/4da data
5.8 Using Create Roads

We are going to create the roadways from the road centre lines (vertical grading has already been done). First we will need the road templates that we will read from a templates file.

File IO=>Templates input

Now we are ready to create the road strings and design tin.

Design=>Roads=>Create=>Create Roads - Manager
1. **LB Function** and select the **create roads** function. This has all of the road design details included in it.

2. **LB the Create button**

3. **LB the Finish button.**

4. **Add tin design** onto the plan view.

To view the road strings, add on all of the **road *** models to view **3**. To view the tin add on the **tin design** model. You can also add the **tin design** model onto the perspective view. **Important:** On the OpenGL perspective view, 12d will show the tin data with the greatest z values (when viewed from the top side). Rename view 3 to roads to help organise your work.
5.9 Creating a Super Tin from the Survey and Design Data.

The drainage fs tin may be used to set pipe inverts, pit levels, sag catchment overflow points and catchment slopes for tc strings. Therefore, the tin often needs to include several tins combined into one tin. To create a tin that is the combination of the survey data and the road design data you will need to create a 12d super tin. From the main menu:

Tins=>Create=>supertin

1. Type a New tin name of combined. Press Enter!
2. RB in the cell and select the existing tin.
3. RB in the cell and select the design tin.
4. LB the Create button.
5. LB the Finish button.
6. Add tin combined onto the plan view.

Notes about super tins:
- tin colour is only used in section views,
- the super tin is the 2 tins “glued” together,
- the super tin is Opaque so it will “cover up” other models already on the view. Use the Menu button on the View toolstrip and select Models->models to back and select the super tin.

- The order of the tins is very important. Tin 1 is the first to be drawn then tin 2 is drawn. i.e. wherever tin 2 exists it will be used. If there is no tin 2 at a location then tin 1 will be used.

5.10 Changing the Colour of a Tin

To emphasise the super tin is just the tins “glued” together, we will change the colour of the existing tin and see how the super tin changes colour as well.
Toggle the **Tin solid** on and note the colours of the super tin.

---

**Tins=>Colour=>Colour of tin**

1. LB tin icon and select the **existing** tin
2. LB colour icon and select **dark green**
3. LB **Colour**
4. LB **Finish**
6. Drainage Overland Flow Investigation

Where a drainage designer chooses to start their design is depends a great deal on the project and the designer. Identifying overland flow routes, with the crest and sag points, is essential because it is on these routes that the inlets are to be placed. Inlet structures are then placed at the critical locations (sag points, flattening of grades, intersections, upstream of pedestrian crossings etc.) and then the spacing of additional inlets is determined by the size of the catchments. Finally, the pipe drainage system can be created linking the drainage structures.

Following is a list of 12d tools to identify surface flow routes:

- Change the Flow Arrow Length and Colour
- Downhill Strings
- Locating Crests and Sag Points
- Rain drop

6.1 Downhill Strings

Roads are generally designed with a flow path in the cross section shape. In this example the roadway has a dual crossfall with kerb and gutters. We will use the downhill strings option to locate all the inverts strings, change their line style to a flow arrow, split them at their crest and sag points and ensure the chainage increases in the downhill direction.

From the main menu select

```
Design->Drainage-Sewer->Downhill strings
```

1. type `Road*Strs` (it is case sensitive). These are the models that contain all of the road strings. *Road 1 Strs* for example.
2. type `*inv`. The road string models have a `linv` and `rinv` string for the invert of the kerb and gutters.
3. type `dr overland flow` to create a model for the new strings
4. Select Run
5. add the model `dr overland flow` onto the roads view.

6.2 Locating Crests and Sag Points

This step will place tick marks at the crest and sag points of your kerb strings and label them with the levels.

```
Strings =>Label => Chainages
```

Add all of the models beginning with Road onto plan view 1.

1. Select the filter button
2. Select the View tab
3. Select the Roads view
4. Select the String Info tab
5. Type *inv to so that the linv and rinv strings will be selected.
6. Select Filter Select to select the inv strings to be labelled.
7. Select crests/sags from drop down list.
8. Enter a model to contain the text labels. A .1 after the model name, requests that the model be added to view 1. This saves you adding the model to the view later to see the labels.

9. Select icon to define the text style.

10. Untick Chainages

11. Tick Heights

12. Select Label

13. Select Marks tab

14. Select the model used above for the tick marks.

15. LB to select ticks centred from the drop down list.

16. 10m marks stand out well on the screen.

17. Set colour to yellow

18. Select Label to create the labels.
6.3 Creating a Filter Favourite

1. Before closing the panels, create a filter favourite that can be used later. Select the Star button.

2. Select [Create].

3. Type drainage inverts.

4. Select Create.

5. Select Finish. The favourite is now created for later use. Select Finish to remove the panel.

Now add the model **dr crests and sags** onto the **roads** view.

6.4 Rain drop

The raindrop routine will create a line from a selected point and follow either up or down the tin.

From the main menu select

**Design->Drainage-Sewer->Rain drop**

Try selecting several points on the tin to see the flow lines that are created.
7. Setting Drainage Defaults (Initial Settings)

Before creating drainage strings in 12d we should set default values for the pit and pipes. These defaults are only used as initial settings for new manholes and pipes. This ensures that most of the pit and pipes will have the desired type, size etc and then we only need to modify the pit and pipes that are different to the default values. The defaults for the drainage network are accessed through three panels: pipe defaults, manhole defaults and Tin defaults.

7.1 Tin Default

The 12d drainage module is designed so that no levels need to be manually entered into the drainage system (although they can be and locked if desired). The primary source for these levels is a design tin but levels from design strings and polygons can be used as well.

Design => Drainage-Sewer => Defaults => Tin

The default TIN is used to set the initial manhole cover level and the pipe invert levels (via pipe cover or depth settings discussed later). Super tins may be used if you want to place manholes on both the existing and the design ground surface (see Creating a Super Tin from the Survey and Design Data).

1. LB the tin icon and select the combined tin.
2. LB the Set button
3. LB the Finish button.

If you place a pit outside the tin boundary:

1. then no elevation will be set for the top of the pit, (it can be set later manually or by linking it to a road design string).
2. Pipe invert levels cannot be set using the default cover. Pipe invert levels must be set manually as 12d cannot automatically determine cover levels without a TIN.
3. Finally, if you are exporting to an external drainage design program that accepts surface levels along the string, then an error message will be displayed at export time. The message will say that the surface level string is shorter than the pipe length.

7.2 Manhole (Pit) Defaults

Notes on pit Diameters

The pit diameter/size is specified in metres/feet not mm/inches. The size of the pit is generally set in the drainage 4d file as either circular (mhdiam) or rectangular (mhsize). If both commands are specified then the mhsize command takes precedence. Plan drawings may use a symbol via the drainage plot annotations.

The Diameter is used for:

1. for visual service clash identification in long section drawings,
2. to clip the pipe lines drawn in the plan annotations so that symbols can be inserted in the space created,
3. maximum distance the bypass flow strings can be drawn from an inlet centre.

The minimum drop will be used to set the invert level of the outlet pipe relative to the invert level of the inlet pipes. The drop should always be entered as a positive value. The DNE has many more options for aligning the pipe inverts at the pits. The drop may vary with the pipe deflection angle via the DNE->Defaults->Pipe->Drop file.

Setting the default name to New is a good reminder that you have not confirmed the pit type. Use the Set Pit Names function on the DNE to assign the pit names.

The pit type list is obtained from the drainage.4d file. Set this to the most common pit type and then later change the ones that are different using the DNE.

You must click the Set button to set the default values. Finish alone will not set the defaults.

7.3 Pipe Defaults

The pipe diameter is set in metres or feet not mm or inches. Set this to a common pipe diameter for your project then alter other pipes or change to box culverts in the DNE.

Pipe Thickness for Pipe Cover

When 12d set the pipe inverts it checks the minimum cover from the top of the pipe to the finished ground surface at the ends of the pipe. Pipe thickness is changed by pipe type as defined in the drainage.4d file.

Cover = surface level - thickness - pipe diameter(height) - invert

If the grade of the pipe is less than the minimum grade, the grade of the pipe is increased. The DNE has a pipe grade file where the minimum grade may be changed via the pipe diameter.

Finally, 12d checks if there is anywhere along the pipe length that has less than the minimum cover. If there is such a low point in the design surface, the pipe is shifted vertically downwards to achieve the cover.
required. The **DNE** has a pipe cover file that will change the pipe cover via the pipe type. If the pipe type is not found in this file then this minimum cover will be used. Circular pipes have the cover checked along the centre line and box culverts along the centre line and edges. When using the 12d editors to change the pipe diameters the invert levels will remain fixed and the obverts will change. The inverts may be reset using **Regrade Network** on the **network editor**.

The list of available pipe types is set in the **drainage.4d** file.

### 7.4 String Colour and pit Label Text Size/location (string defaults)

12d can automatically label the pits at a fixed offset from the pit using **view text** OR you can use the network editor **Plot** to create text labels that can be moved/rotated etc.

For view text, the default line colour and text size are set by selecting

**Project=>Management =>Defaults**

The following panel will appear.

1. **LB colour** icon to set the default colour of the drainage string and manhole labels.
2. **Type the height of the text in pixels**
3. **LB the Set button**. This will set the defaults for this project only.
4. **LB the Finish button**.

The manhole label textstyle and offset may be changed via the **DNE->Global->display tab**
Optionally, you may LB the Write button to set the defaults for other projects. The following panel will appear. Selecting Current folder will save ALL these defaults for projects in this working folder only. The defaults set in the user or setups directories will not be used if you select this option.

Selecting User folder will save your defaults so that all other 12d projects will use these defaults. This is the most common option (unless your network administrator has not given you write access to this folder (check Properties in windows explorer).

Select Write then Finish
8. Creating Drainage Strings

We are now going to create a culvert to cross road 3.

Key Points

1. Before creating the drainage strings, read in a drainage model template (Design->Drainage-Sewer->Create->Create/Read template) so that all of DNE settings will set. There is a sample one in the 12d library (drainage_template_QLD.12da). If you forget, do it later but READ A TEMPLATE FILE. We will create one at the end of this course.

2. You will be placing centre of the culvert headwall. The headwall centre is the selection point for the pit. Pipes can be connected this pit Use setout strings for construction setout points!

3. Drawing all drainage lines in the same direction may help you keep your drainage work organised. Either draw all string uphill to downhill (flow same as string direction) OR downhill to uphill (flow opposite to string direction). You can mix the flow directions if desired.

4. The Drainage Network Editor Regrade Pipes is the key to setting pipe invert levels! Use this after modifying the drainage plan layout as it will update all initial grading described below.

However, 12d will perform an initial grading as you draw the string. If you choose opposite to string direction then will need to select Pipe=>Default Grading then Grade to achieve this initial estimate. If you create branch lines before the trunk lines the initial grading will ensure the trunk line inverts remain below the branch line. Regardless, the DNE regrade pipes will sort the grading for all strings in the model.

8.1 Read in a drainage model template

A drainage model template contains your favourite global and default settings for the DNE. These settings are stored as model attributes and the template may be read before or after the drainage strings have been created. Caution: existing default and global setting may be overridden.

You can create your own templates as well. After you have completed a drainage job and all of your global and default settings are set, create a template to save in your user library.

From the main menu select

Design => Drainage-Sewer => Create->Create/Read template

1. Leave as Read.
2. Type drainage to create a new model for the drainage strings
3. LB the folder icon, then lib to locate drainage_template_QLD.12da
4. LB Process to create the model and import the default and global settings.

8.2 Creating the Drainage Strings in 12d

12d has a routine that creates a culvert very quickly. Design->Drainage-Sewer->Create->Culvert. It will also add a channel to the outlet as well! Try this, then the general method discussed below. The culvert is placed in a model culvert and the levels are all set to the manual mode.
A drainage string is created by selecting

**Design => Drainage-Sewer => Create->Create**

The initial manhole and pipe types will those set in Setting Drainage Defaults (Initial Settings).

1. Type a string name (used for pit naming later).
2. Type a new model name for the network
3. LB the Colour icon and select colour (optional).
4. Leave unless drawing in uphill direction.
5. From the default, leave as is.
6. Existing tin can be used for long section dwg levels
7. Select if creating more than 1 string.
8. LB the Create button, the menu below will appear.

If you have already created a drainage string, click the Same as button and select the drainage string to obtain the panel values from that string. After selecting the string, change the string Name.

We are going to initially place our head walls on edge of the batters and then fine tune the location later.

To create your first manhole select

1. Edits => Add/Append MH. A +MH will appear with your pointer. Refer to the plan below for the headwall locations.
2. LB and accept for the upstream (east) and downstream (west) headwalls.
3. LB the Finish button after the last headwall is placed.
8.3 Change Pit and Pipe Types and Sizes

We will use the DNE to change the structures to inlet and outlet headwalls and the pipe to a box culvert.

The drainage network editor is accessed through the main menu by selecting

**Design=>Drainage-Sewer=>Network Editor**

The bottom section of the network editor panel is shown below. You can change tabs but no data can be entered in the panel until a drainage pit or pipe has been selected and accepted.

1. Pick and accept the drainage string near the western headwall and the network will be loaded into the panel (only drainage strings may be picked).

The action buttons on the drainage editor now become active.

The pit closest to the point selected is highlighted with a circle and an arrow shows the direction of flow and the pipe being edited (see image below). When the outlet is selected there is no arrow. If the arrow is in the wrong direction or the outlet is at the upstream end of the string see **Flow in the Wrong Direction** to correct this.
1. Select the **Pit Tab**

2. Note the **Pit type** is already **HW** as we set this as the default. The type may be used to set pit properties. See [Drainage Definitions - Manhole Types](#) in 12d help. If you did not set this as your default (**Manhole (Pit) Defaults**) then change it now.

3. Diameter/length is in the direction of the road once it is linked otherwise it is east-west. Width is 90 degrees to this. If width is blank the pit is circular.

4. Select **Apply** to see the changes.

---

1. Select the **Pipe Tab**

2. Change the **Pipe type** to **BC** (for box culvert). This may be used to set some of the pipe properties. See [Drainage Definitions - Pipe Types](#) in 12d help.

3. Change **Diam/height** to 0.375 and width to 0.600. If width is blank the pipe is circular.
A popup will appear indicating that the pipe thickness will be changed because the pipe type has a different thickness setting in the drainage. Select Stop asking for this session and then click Update.

8.4 Flow in the Wrong Direction

The direction of flow is used by 12d to determine which end of the string is the outlet and therefore the direction of decreasing invert elevations when regrading the string.

The direction of flow will be indicated with the arrow on the pit when using the DNE. No arrow will appear if the outlet is selected. If you find the arrow is pointing in the wrong direction there are 2 methods to access the flow directions.

**Method 1:** Use the DNE to select the string with the flow in the wrong direction and then select the String Editor button. From the menu select Utility->Properties. Change the Flow direction value to the other value. Select OK then Save & Finish. Now use the Pick button to select the drainage network again.

**Method 2:** Use the Strings->Properties->String option from the main menu. Select the string and then change the Flow direction value to the other value.
9. Drainage Strings Levels

The DNE quickly sets the levels for your drainage network. All the levels can be calculated by the DNE or locked with user specified values.

9.1 Pit Levels

Pits have 4 levels:

1. The cover level is used in plotting and pit depth calculations. This is also the maximum obvert level drawn for all connecting pipes.
2. The grate level is used for the freeboard measurements, the surcharge to bypass level and the reference level for pond flooding depths.
3. The setout level is used for survey setout to construct the pit.
4. The sump level (bottom of the pit) is used in plotting and for depth calculations. If set to floating mode, it is calculated from the lowest pipe invert connected to the pit plus the sump offset.

The grate level is the most important level in 12d hydraulics and will be discussed more in those sections.

9.2 Pipe Levels

Pipes have the upstream and downstream invert levels that can set by the minimum grade and cover criteria (see Vertical Alignment - Pipes). The invert drop across a pit can also be fixed or change with the deflection angle. At this time we are only concerned with the pipe cover and grade.

9.3 Section View of a Drainage String

Create a section view to profile the drainage string.

From the main menu select View->Create->Section view

1. Type Drainage
2. Select the Create button
9.4 Set Pit Details

Selecting **Set Pit Details** will set the pit levels and setout coordinates for all of the pits in the network using either the default settings for the model or the explicit settings for the pit (if used). Other attributes are set as well but they will be discussed later. A prompt box appears asking you to confirm. Select Yes.
9.5 Regrade Pipes

Selecting the **Regrade Pipes** button sets the pipe inverts for all of the pipe in the network using either the default settings for the model or the explicit settings for the pipe (if used). A prompt box appears asking you to confirm. Select **Yes**. To toggle off/on the confirm request RB **Regrade Pipes**.

Minimum grade and cover are checked and trunk lines are lowered to accept incoming branch lines. Grade is calculated using either the pit centre to centre distance or the end of pipe to end of pipe distance (**DNE**-**Global** Use end to end pipe length). Default pipe cover and grade are set on the **DNE Defaults-Pipe** tab and if not found there the **Drainage->Defaults-Pipe** settings are used.

Invert alignment is based on the pipe cover, the pipe minimum grade and the drop across the pit (see **Pipe Grade Modes**). The tin specified in the **Global-Main Finished Surface Tin** box is used for these calculations. Since every pipe that enters the pit may have a different drop mode, the drop mode is set on the downstream end of the pipe, NOT the pit.

If the inverts are locked on the **Pipe** tab then some the design criteria may not be able to be achieved. Messages in the output window will indicate these problems.

Now we will regrade the culvert checking the cover only under the roadway. First select the upstream (east) headwall.

1. Select the **Pipe** tab
2. Select the **Design** tab
3. Type **0.6** to over ride the default cover we set earlier (this is the minimum distance measured from the top of the pipe).
4. Type **2.5** for the Skip cover distances (US and DS). These distances are measured from the ends of the pipe. This will stop 12d from checking the cover in these areas.
5. Select **Regrade Pipe** to reset the inverts.

For circular pipes, the cover is checked along the centre line of the pipe. For box culverts the cover is also measured along the sides. The wall thickness is set via the pipe type and diameter from the drainage.4d file.
9.6 Setout Strings to Align the Headwalls with the Roadway

Now link the headwalls to the roadway so they are perpendicular to the batter slope.

Note: The obvert of the pipe will never be drawn above the grate levels. If the cover or grate level is below the pipe invert you will get an X pipe. Set pit details will recalculate the pit levels and Regrade pipe to set the inverts.

1. Select Global
2. Select Utility Models
3. Type road strings
4. Select the folder icon then Open

1. RB in the Road Strings Model cell and select Road 3 Strs model
   type *bok so that the headwall will be linked to the closest lbok or rbok string.
   type 10 as the max distance to search for a string

2. LB Write to save the file
3. Select Finish
4. Select Set Pit Details to create the links to the road strings.
The culvert headwalls now align with the roadway instead of east-west.

Now confirm the manhole link to the road strings (setout strings).

DNE string links exist until you manually clear them or you delete the string. OR you clear the link by RB on the manual pick and select **Clear**, OR you clear all road string links via **Global->Utility Models->Clear Road Links**. We have a good link so do not do this at this time.

9.7 Adjust Pipe Length

Now adjust the culvert length to an even number of pipe lengths.

Only one editor at a time can access the strings. The DNE locks all of the strings in the model. Close the DNE now, before we start the next editor.

From the main menu select

**Design->Drainage-Sewer->More->Extend pipe/culvert**
As the culvert appears to be too long we will shorten it to 10 standard lengths (half on both ends).

1. Pick and accept the culvert
2. Change **End to extend** to **high chainage**
3. Change **Standard length** to 2.46
4. Change **Gap length** to 0.010
5. Change **Num pipes** to 11 and press enter. the new length is displayed
6. Select **Process**
7. Select **Finish**

After selecting process, the section view will need updating. Also the pit cover levels are set to the pipe invert level. The next time you press **Set pit details** in the DNE they will be reset using the selected method.
10. Importing Drainage Layouts from AutoCAD

We are now going to import a pipe layout that was drawn in CAD along with the overland flow routes and catchment areas (These could have been created in 12d as well). When these were drawn the following rules were followed:

1. Strings are drawn where the pipes are NOT to setout x,y locations,
2. Polylines are used in AutoCAD,
3. Lines drawn from upstream to downstream (direction of flow),
4. A vertex was placed at every pit location.

To import the AutoCAD drawing, from the main menu select

File IO->Data Input=>DWG/DXF/DXB

1. Select 2012 support
2. LB the folder icon and select the drainage data.dwg file
3. Type a prefix for the models. It will help organise the layers from AutoCAD as every layer goes into a separate model in 12d. Specifying a prefix causes all of the layer names to be prefixed with this text and therefore kept together in the model list. The prefix used is dwg<space>.
4. Enter the null value 0 (no level in CAD value)
5. LB Read button. If you select the Read button more than once the data will be imported again and you will get duplicate, triplicate...etc data.
6. LB Finish

The models that have been created are,

dwg Catches Future
dwg Catch Lots
dwg Catch Reserve
dwg Catch Roads
dwg network
dwg network is a drainage layout that we will use to locate the pits in our drainage design.

10.1 Checking the String Direction of CAD Network Strings

A quick way to check the direction of the strings imported from CAD is to change the linestyle to a style that indicates the direction.

From the main menu select,

Utilities->A-G->Change
10.2 Create the drainage strings from the CAD strings

Before creating the drainage strings, Read in a drainage model template so that all of DNE settings will be set. If you forget, do it later but READ A TEMPLATE FILE. If the drainage strings are going to be added to a model that already has the global and default settings set, these strings will use those model settings.

12d will convert the import strings into 12d drainage strings. The default pipe, pit and tin data will be used to set the levels for the network. Do not use the other string convert commands found on the menu system.

Most of the pits will be grated roadway side entry pits (AL2D). Set this pit type as the default.

Design => Drainage-Sewer => Defaults => Manholes

1. LB the Type drop down and select AL2D.
2. LB the Set button.
3. LB the Finish button.

Next from the menu select

Design => Drainage-Sewer => Create => Create from strings

The following panel will appear.
1. Select the existing **dwg network** model
2. Select the **combined** tin. The cover level for the manholes will be obtained at the manhole centres from this tin.
3. Leave as **same as string direction**. The strings were drawn in the same direct as the flow in the CAD program.
4. Select the existing **drainage** model. If this model was not created from the read drainage model template function then you could type the name now and the model would be created.
5. **Clean drainage model** when selected will delete all strings in the model before the new drainage strings are created.
6. **Process** create the drainage strings
7. **Finish** closes the panel

The imported strings must all be drawn in the same direction. Either all in the direction the water flows or all opposite the direction of flow.

- Pits are created at all vertices on the strings.
- Trunk lines must have a vertex where the branch lines join.

Delete the new plan that was created and observe the new drainage strings created (road view).
11. Horizontal Alignment and Drainage String Edits

11.1 Road design strings (centre line) for Adjust Pit Locations

During the design process, roadways are often moved slightly, requiring the pit location to be adjusted. Linking the inlets to the road design strings enables 12d to quickly adjust these locations and create a report of the pit requiring adjustment.

The Adjust Pit Locations routine will move the centre of the pit perpendicularly to a layout string or offset from a road setout string.

Layout strings do not need to be set up in advance but they do not allow for an offset. Road design strings need to be setup in the DNE but the allow an offset from the setout string that can vary with the pit type. Often large pits will be offset more into the footpath or roadway.

Road and layout strings can be used at the same time. If no road string is found, a layout string will be searched for.

In this example were are going to use the road setout strings not layout strings. We have already linked the culvert headwalls to the road design strings on Road 3. We will now do the same for the roadway inlets so they will align with the roadway and we can offset the centre of the pit a fixed distance from the setout string. This will require a link to the road centre line as well. A positive offset is away from the centre line and negative towards the centre line.

Start the DNE and select the network.

1. Select Global
2. Select Utility Models
3. Select the folder icon then Open
To confirm that the inlets were linked to setout (*bok) and centre line strings,

1. RB in the Road Strings Model cell and select Road 2 Strs model
   type *bok so that the inlets will be linked to the closest lbok or rbok string.
   type 3 as the max distance to search for a string
2. press enter until row 3 is added
3. type * for Centre String ID.
   This wild card will allow a string with any name (blank will not work).
   type 10 as the max distance to search for a string
4. LB Write, then Replace to save the file
5. Select Finish then Set Pit Details to create the links to the road strings.
6. Regrade pipe to set the inverts.

1. LB Pit
2. LB Setout
3. Note: selected string
4. Note: manual pick/clear button

11.2 Log Lines with the Drainage Network Editor

Double clicking on a log line in the Output window will take the DNE directly to the pit the message refers to!

Selecting Set Pit Details and messages are created in the Output Window for information and error checking. If the line of text begins with a exclamation mark it is a log line.
No road setout string has been found because we have not included the model Road 1 Strs in the Road strings file found on the Global->Utility Models tab of the DNE. The *bok strings in the Road 2 Strs and Road 3 Strs were more than the search distance away.

1. Add the new row and complete with the data as you have done before.
2. After Writing the file select Set Pit details.
3. Confirm that I-11 now has a setout string.
11.3 Adjust Pit Locations

Now we can offset the inlets from the bok setout strings.

Close the DNE and then from the main menu select,

Design->Drainage-Sewer->Adjust pit locations

1. Select the model drainage.
2. ensure Use road strings is selected.
3. RB and select AL2D pit type
4. type 0.450 for the offset away from the road centre line
5. Layout strings and layout search distance are not being used at this 
time.
6. Select Process and redraw the plan view to see the new pit loca-
tions.
7. Select Finish

The message box indicates that 13 of the 18 pits were adjusted. Check the output window for a list of the pits that were adjusted. If no road string is found then the layout string is searched for. Since we did not use layout strings we get the warning messages for 3 of the pits. Note: You will not have pit names assigned yet (Set Pit names (and pipes)) so your names will be just NEW.

WARNING: Adjust Pit Locations - pit "I-07" found no perpendicular layout string within the specified search distance.
INFO: Adjust Pit Locations - pit "I-04" adjusted by 2.610 units.
WARNING: Adjust Pit Locations - pit "I-08" found no perpendicular layout string within the specified search distance.
INFO: Adjust Pit Locations - pit "I-05" adjusted by 2.610 units.
INFO: Adjust Pit Locations - pit "I-06" adjusted by 2.610 units.
INFO: Adjust Pit Locations - pit "I-07" adjusted by 2.610 units.
INFO: Adjust Pit Locations - pit "I-08" adjusted by 2.610 units.
WARNING: Adjust Pit Locations - pit "I-10" found no perpendicular layout string within the specified search distance.
INFO: Adjust Pit Locations - pit "I-09" adjusted by 2.610 units.
INFO: Adjust Pit Locations - pit "I-10" adjusted by 2.610 units.
WARNING: Adjust Pit Locations - pit "I-11" found no perpendicular layout string within the specified search distance.
WARNING: Adjust Pit Locations - pit "I-12" found no perpendicular layout string within the specified search distance.
11.4 Manual Horizontal Alignment - Moving, Adding and Deleting Pits

The most common functions for adjusting the horizontal alignment of manholes and pipes are found on the Strings->Points Edit menu.

The **Append, Between, Delete, Insert and Move** commands are the most common.

The **Move** command has extra options for moving junction pits. Selecting **All points with the same coordinate** will move all points on the view that are at the same x,y coordinate. The point selected will move first and the others will follow after the new location has been accepted. **Restrict to selected model** will stop data from other models at the same location from being moved.

The second option

**Strings->Edit**

gives you all the same commands and more but requires you to select a string first and the edit commands will be restricted to the selected string.
12. Completing the Intersection Drainage Design

When placing inlets around an intersection, it is often required to place the centre of the inlet a specified distance from the curve so that the grate and/or the side inlet will be located on the straight section of kerb. If there is a pedestrian crossing, the inlet should be placed at a specified distance upstream to be clear of the crossing.

12.1 Placing Marker Points around the Intersection

The place points routine is a fast way to place inlet location markers at a specified location from the curved section of the kerb.

From the main menu select

Design->Drainage-Sewer->More->Place points

1. Select the Roads view as it contains the inv strings where we want the pipes.

2. Type *inv so the linv and rinv strings can be selected.

3. Type the distance from the end of the string or the start of curve where the pit is to be placed.

4. Select Pick point and then snap near where the pit is to be placed. The routine will find the closest *inv string and then search for the closest end or curve. It will then measure from the point towards your initial snap to create the marker (see magenta arrows below).

5. repeat for the remaining 3 ends of the kerb returns.

12.2 Option 1 (Connection at Manhole in the Road)

The option below has been selected for you to complete so that it has 2 inlets and a manhole. Use the tools you have learnt thus far to create the drainage string and assign the pit names. Special care is required when creating a junction pit (10) shown below. There must be a pit on the trunk line where the branch line connects and there branch line must point snap onto the centre of the trunk line pit (see Junction Pits).
12.3 Option 2 (Connection pipe under the footpath)

Some road authorities prefer not to have a manhole in the intersection. Move the connection pit to the inlet to the west and delete the manhole.

A check list is on the following page once you have completed the layout.

12.4 Intersection Check List

1. Did you place the pipes in the correct location so that the correct cover could be measured?
2. When placing the manhole did you use the RB and **Perpendicular** to place the manhole?
3. Did you use **Strings->Points Edit->Insert** to add a pit to the trunk line at the junction location?
4. Did you assign a unique string number to the new string so that the set pit names routine would run?
5. Did you select **Set Pit Details** in the **DNE** to ensure the cover, grate and setout data was correctly calculated?
6. Did you check the output window for problem messages? Did you fix them?
7. Did you recalc the function **Adjust pits** so that the inlets are 0.450 behind the bok string.

Below are 2 other methods for placing pits that you may find useful.

12.5 Offsets from strings

As an alternative to the place points above you can use the snaps CAD to place the pits “on the fly”. Once the points move has been started use the **RB** and select **Snaps Cad=>Points=>Locate Offset**. Follow the prompts given in the message area (bottom left corner of the screen). You will need experience with the 12d “directional pick” to use this capability.

12.6 Placing pits at specific Easting Northing Locations

For locating pits at specific x, y coordinates, simply start typing the x coordinate instead of clicking onto a location. An input panel will appear for you to enter the x and y coordinate separated by a space.
13. Manholes - A Closer Look

A manhole is made up of 3 points; the centre of the manhole and the pit-pipe connection points. The pipe exists as the connection between two manholes. The pipe may have a horizontal radius but not vertical.

13.1 Pit-Pipe Connection Points

The default mode has the pipes align between the centres of the manholes. The pit-pipe connection points are at the intersection of the manhole interior wall and the centre of the pipe (see below).

These connection points may be moved by enabling **Use pit connection points** on the DNE->Global->Main tab. All pits have their connection point initially set to **Points**. This setting is found on the DNE->Pits->Setout tab.

Pit connection points may be moved via **Strings->Points Edit->Move** (except for **Centre** mode described below). If a pipe is manually moved to a new connection point, it will be locked to the connection point and will not move if the pit or neighbouring pit is moved.
13.1.1 Pit Connection Point Modes

**Centre** (rectangle and circular) - This mode is the same as having the *Use connection points* turned off. The connection points will be located on the inside perimeter of the pit wall with the centre line of the pipe intersecting the centre of the pit. In this mode, the connection points may not be adjusted.

**Points** (rectangle) - A connection point is created at the mid point of each internal side of the pit. This may be changed for a *Pit type* by using the *con_points* command in the drainage.4d file. In this mode, the pipe ends will snap to the connection points. It is possible to place more than one pipe on the same connection point (the elevation of the pipes is not checked for clashes).

**Points** (circular) - The connection point may be moved anywhere around the pit internal wall as there are no connection points on the circular pits. Again, it is possible to place more than one pipe on the same connection location (the elevation of the pipes are not checked for clashes). If the manhole centre is moved the connection point locks are removed.

**Perimeter** (rectangular and circular) - Same as **Points** (circular) above.

**Unrestricted** (rectangular and circular) - There are no constraints on the location of the pit connection points. This mode is intended for irregular shapes such as GPT structures and stormwater basins.

---

1. Close the DNE to unlock the drainage strings.
2. Use **Strings->Points Edit->Move** to move the junction pit you added to complete the intersection westward to the inlet.
3. Use **Strings->Points Edit->Move** to move the ends of the pipes as shown. Note that the pipes snap to the centre of the edges.
13.2 Junction Pits

Key Points

1. The branch line must **Point Snap** onto the centre of a pit on the trunk line.
2. Both strings must be in the same model.
3. The downstream end of the string (depends on flow direction) must join onto the trunk line.

When creating a junction, pit turn the point snap on and the line snap off (the F3 and F4 keys are convenient for this). Zoom into the pit so that you can snap the being moved onto the centre of the stationary pit.

Recall a pit contains three points; one at each pit pipe connection points and one at the pit centre. You want to snap onto at the pit centre for a junction pit. In the figure below, the blue line is being placed to join the white line. Note that the diamond indicates that there is a point snap as well as the information panel.
13.3 Drainage Section Views (downhill left to right OR right to left)

The long section views and the profile plots are running downhill from left to right. If you want them downhill from right to left use the reverse function.

To reverse only one string, from the main menu select

Strings => Strings Edit => Reverse

and pick the drainage strings to reverse. This will also change the drainage flow direction attribute from same as string direction to opposite to string direction.

To reverse all of the strings in a model select the Reverse all strings option,

Design => Drainage-Sewer => More => Reverse all strings
13.4 Drainage Split and Join

In this example, we are going to **split** the string shown in white below at IN14 (your pit are still NEW) so that we can **join** the west end (IN14 to IN16) to the trunk line on the southern side of the road (cyan). This will allow us to produce a long section that will extend the full length of the road 2 to the headwall outlet.

Use the **String split/join** from the Drainage menu not the one on the **Strings->Strings edit**.

**Split Option**

The split must be done at a pit.
1. A new name for the upstream string (optional). Leave it blank.
2. A new name for the downstream string (optional). Leave it blank.
3. LB the **Split** button and then select the pit where the split is to occur. (IN14).

**Join Option**

This routine will add a new pipe between the 2 strings if required. When **Join US to DS** is selected, the properties and attributes of the upstream string and pit at the join will transfer to the new joined string. **Join DS to US** will cause the properties and attributes to come from the ds string. Upstream and downstream is determined by the flow direction.

1. Select the **Join US to DS** button.
2. Pick and accept the cyan drainage string, then the IN14 to IN16 string (follow the messages in the 12d message area).
14. Drainage Network Editor (DNE)

We have had a brief introduction to the DNE when we worked with the culvert. We will now look at many more of the DNE capabilities.

Read in a drainage model template! There is no need to set all of your global and default settings each time you start a new job. If we had not already read in a template we would do it now. Templates are a way to store all of your Network Editor - Global, Default Settings and Explicit Settings

The drainage network editor is used to automatically or manually change the properties of your drainage network. These abilities include:

- **Vertical Alignment - Manholes**
- **Set Pit names (and pipes)**
- **Service and Utility Clashes**

**Hydrology**

- **Catchment Areas**
- **Catchment Areas and Percent Impervious**
- **Coefficients of Runoff**
- **Times of Concentration**
- **Tc Path Strings**
- **Bypass flow routes**

**Hydraulics**

- **Cover RL, Grate RL, Setout RL and Sump RL modes,**
- **Culvert Hydraulics and Tailwater**
- **Pit Losses Ku, and Direct Flow**
- **Pipe Friction Method, Roughness Values and Direct pipe flow**
- **Design mode, Freeboard Limit and Flow-depth limit**
- **Pipe Size Design**
- **Pipe Design Parameters - Sizes, Invert alignment, Min Cover, Max Height**

The DNE also links your drainage model to your 12d design models.

---

The drainage network editor is accessed through the main menu by selecting

Design=>Drainage-Sewer=>Network Editor
There is no need to fill in all the fields. On the **Catchment**, **pit** and **pipe** tabs, blank fields will use default values from the **Defaults** tab. Check the tool tip for the default value being used.

The bottom section of the network editor panel is shown below. You can change tabs but no data can be entered in the panel until a drainage pit or pipe has been selected.

1. Pick and accept a drainage string and the network will be loaded into the panel (only drainage strings may be picked).

The pit closest to the point selected is highlighted with a circle and an arrow shows the direction of flow and the pipe being edited (see image below). When the outlet is selected there is no arrow. The option buttons on the drainage editor now become active.

14.1 Update from drainage.4d

We have set our default diameter as 1m and default manhole as AL2D. In the drainage.4d file the AL2D manhole is defined having a diameter/length of 0.93m and a width of 0.85m. When you select one of the manholes the DNE finds the difference and asks you if you want to update the manhole diameter.

1. Select **Update from drainage.4d**. The manhole diameter will now be changed to 0.93 for this manhole.
2. If you select **Stop asking for this DNE session** first, you will not be prompted before the DNE updates the manhole data.
3. Selecting **Set Pit details** will update all manhole diameters in the network.

A surveyor who received a 12da file of the drainage network without the drainage.4d file would select **Keep stored data**.
14.2 Moving through the Drainage Network

There are 3 ways to change pits in the network editor. The Next-Previous (chainage NOT flow direction or east west) buttons will work if you are on the **Defaults**, **Global** or **Results** tabs. If the editor finds an error on a pit, it will take you to the error and you must correct the error before moving to the next pit.

Try all 3. The **GoTo List** will be interesting as we have not assigned pit names yet.

![Diagram of the drainage network editor](image)

1. Pick Edit Button - Pick and pit or pipe in section or plan view
2. GoTo List - Select the pit from a list of pit name
3. Next and Previous (chainage) buttons - loop through all of the pits in the network

The most important button on the DNE is the **Set Pit Details** button. This button calculates the all of the manhole levels and data required for the drainage calculations.

14.3 Auto-Apply, Auto-Pan, Auto-Profile and Auto-Redraw

To tell if these buttons are on or off you need to know your computer display settings. For Windows 7, the default is Blue for on.

With **Auto-Apply** (A) enabled, data is saved when any of the 15 lower buttons are pressed except **Finish** and **Help**.

**Auto-Pan** is always active and any plan view showing the active drainage network selected will always auto pan if the selected pit is not in the view.

With the **Auto-Profile** (P) enabled, the same will happen for the section view.

With **Auto-Redraw** (R) enabled, the editor will regenerate the section view when changes are made in the vertical. This saves selecting **Regen** on the section views.

14.4 Set Pit names (and pipes)

Pit names are used to identify and label the pits for access. The DNE Goto drop down and outlout window loglines (warning/problem messages) become much more meaningful. **Storm analysis** requires that unique pit names be set.
Use the DNE to manually change single pit names (in the Pit field) or quickly change all the names using the Set Pit Names button.

The Set Pit Names button requires unique string names. To view string names on the plan view, go to the Plan View tool bar and select Toggle=>Names. If they do not appear see Displaying View Text.

**Models->String Info table** is a fast way to view all the string names in the model. Double clicking on the lines will launch an editor to change the string names. The DNE also sorts the strings based on these names and this controls the plotting order.

The string names may be changed in the String field when the Catchment, Pit or Pipe tabs are selected at the top of the DNE. The string names must be unique.

1. Select **Set Pit Names** and the following panel will appear.

1. Select **Sequential Numbering** to number the manholes starting at First Pit Number.

2. Change the **Default naming** parameters.
   - **Map pit numbers to letters** causes the first pit to be A instead of 1.
   - **Min digits in pit numbers** set to 2 causes 1 to be 01.

3. **Run** will update the quick text pit names on the plan view.
   - Try other settings!
   - You may find you want to change some of the string names back in the network editor.

4. **Back to the Editor** return to the main editor panel.
   - **Reverse order** starting numbering at the high chainage end of the string instead of the low chainage.

14.5 Set Pit Names using Pit Type

We can customise the pit name prefix, suffix, numbering sequence etc for each pit type. Currently all of the pits have the default pit type. We will now change the outlet pit type to HW and then rename the pits.
1. Move to the outlet using any of the 3 methods.
2. Change the Pit type to HW
3. LB Select Pit Names

1. Type the file name for the pit naming scheme. An example may be found in the library if desired.
2. LB the folder icon and select Open.
14.6 Change Pit Name Textstyle and Offset

The textstyle and offset for the pit name is set on the Global->Display tab of the DNE. It is always shown as pixel text size and cannot be changed to world.

1. RB to select the Pit type or type text with wild card characters as shown
2. Type the Pre text
3. LB Write to save the settings to the file.
4. LB Finish to return to the panel.

Note that the headwall still get the sequential numbering continued from the last numbering method. To start at a new number the Sub sequence group number would have to be included in the file.
1. Select the **Pit label textstyle** icon and then the **Arial 2 centre** favourite.

2. Type the new **Height (u)** as **12** pixels.

3. Select **Set**.

4. Select **Finish**.

5. Select **Apply** from the bottom of the DNE to see the new textstyles.
15. Vertical Alignment - Manholes

The diagram below shows the properties of a manhole. The RL levels may be set manually or calculated via their associated mode and the Set Pit Details button. The Grate RL is used by 12d hydraulics when determining the freeboard level, bypass flows, inlet capacity values at sag inlets and depth of flooding at sag inlets.

The Setout RL is the level used by surveyors to setout the pit.

15.1 Cover RL, Grate RL, Setout RL and Sump RL modes

The default values for the RL modes are set on the DNE->Defaults->Pits tab.
These may be explicitly for an individual pit on the **DNE->Pit->Main** and Setout tabs

<table>
<thead>
<tr>
<th>RL Modes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover RL</td>
<td>Only available for Grade and Setout RL modes. z value will be the same as the cover RL.</td>
</tr>
<tr>
<td>FS Tin</td>
<td>z value from the pit centre x,y location on the DNE-&gt;Global-&gt;Main-&gt;FS tin.</td>
</tr>
<tr>
<td>NS Tin</td>
<td>z value from the pit centre x,y location on the DNE-&gt;Global-&gt;Main-&gt;NS tin.</td>
</tr>
<tr>
<td>Setout String</td>
<td>z value from the string found by dropping the pit centre x,y location perpendicularly onto the setout string (DNE-&gt;Pit-&gt;Setout-&gt;Setout string) and then moving the distance DNE-&gt;Pit-&gt;Setout-&gt;Setout adjustment Sxy.</td>
</tr>
<tr>
<td>Sz+Setout String</td>
<td>z value as for the Setout String plus the value DNE-&gt;Pit-&gt;Setout-&gt;Setout adjustment Sz.</td>
</tr>
<tr>
<td>Max Obvert</td>
<td>z value of the maximum pipe obvert of all the connecting pipes.</td>
</tr>
<tr>
<td>DS Invert</td>
<td>z value</td>
</tr>
<tr>
<td>Sump Invert</td>
<td>Only available for Setout RL. z value from DNE-&gt;Global-&gt;Main-&gt;Sump RL</td>
</tr>
<tr>
<td>Manual</td>
<td>z value entered in the RL field to the right of the mode (field becomes active when this is selected).</td>
</tr>
<tr>
<td>floating</td>
<td>Only available for Sump RL mode. z value is of the minimum pipe invert of all connecting pipes plus the value DNE-&gt;Pit-&gt;Main-&gt;Sump offset</td>
</tr>
</tbody>
</table>

**RL modes for the entire model may be set via**

**Design->Drainage-Sewer->More->Pipe Locks**

This routine has lock modes for pipes as well.
16. Vertical Alignment - Pipes

The pipe invert levels may be set manually or calculated using the DNE->Regrade Pipes button.

Pipe invert mode may be set to locked for the entire model via Design->Drainage-Sewer->More->Pipe Locks

There are many controls to guide 12d in the setting of the pipe inverts and the user may over constrain the network so that no solution is possible. If the minimum cover, grade or drop criteria cannot meet the criteria you have set, a problem message will be in the output window.

16.1 Minimum Cover

The minimum cover can be set via the pipe type and the pipe cover file (optional). If the pipe type is not found in the pipe cover file then the Defaults-Pipes-Cover for the project is used.

16.2 Minimum Grade

Pipe grade has been traditionally measured based on the horizontal distance from pit centre to pit centre. However, this causes issues with surveyors when they use electronic models to set out the drainage pipes. All drainage pipes lengths can now be calculated from the horizontal distance between inside pit edges (or pit connection point for the unrestricted pit connection mode). The alternate pipe length results in a different pipe grade to be calculated in 12d. This option is set one the DNE->Global->Main Use Actual Pipe Lengths.
16.3 Pipe Grade Modes

**Minimum Depth** The cover sets the inverts at each end of the pipe and then the downstream invert is lowered if the minimum grade is not achieved.

**Minimum grade** The pipe is set to the min grade and then lowered to meet the cover requirements.

**Grade from DS** Warning! Minimum cover may not be maintained in this mode. Each pipe has its downstream (ds) invert level set via its **DS pipe alignment** mode. If the downstream pit is the outlet then the cover is used to set the invert level. The upstream invert is set using the minimum grade.

**Const Depth Channel** Warning! Minimum cover, minimum grade and pit alignments are not used in this mode. The obvert of the pipe is set to the finished tin level at the pit centre.

16.4 Downstream Alignment Modes

The amount of the drop is determined first from the **Drop file** and then if required from the manhole default settings for the project. How the drop value is applied is set via the **DS align mode**.

Inverts are moved down, if required, according to the setting in **DS align mode**.

**Min drop** ensures that the inverts drop a minimum of the drop but may be more.

**Min drop<DS-Dia** ensures that the inverts drop a minimum of the drop but may not be more than the downstream pipe diameter. This restricts the max drop so that the water jet will not completely impact the opposite wall of the pit.
**OL-OL Drop** uses the drop value for the obverts. If the downstream pipe is a smaller, then the drop will be applied to the inverts so that water will not be trapped in the pit. If the downstream pipe is larger then the obverts will be aligned as long as the min drop is maintained on the inverts.

**IL-IL Drop** uses the drop value for the inverts.

The **Drop file** contains the drops that change with the pipe deflection angle. A sample file is included in the library.

If only one drop value is to be used set the deflection angle to 180 degrees.

After setting the pit and pipe levels, add the model **tin combined** to the **Drainage** section view. The trunk profile will be similar to the following. Select the toggle button, to toggle on the grades (and pipe lengths).
To inquire about the cover on a pipe use the following option.

**Tins->Inquire->Depth from string**

1. LB to select the tin
2. LB to select the string.
3. Move the pointer in plan or section to monitor the data.

The DNE calculates cover from the top of the pipe NOT the obvert so cover may appear incorrect. Also for box culverts, cover is measured at the edges as well as the centre of the pipe. Finally for multiple pipes, each pipe is checked for cover.
17. Service and Utility Clashes

We will import some services from a 12da file. From the main menu select,

File I/O->Data Input->12da/4da data

1. LB the Folder icon
2. Select the service file
3. LB the Read button.
4. LB the Finish button.
5. Add the model services onto the plan and section views.

12d service clash routines notify the user of crossing services but not parallel services that are close to each other. The clearance values are vertical distances at the centre line of the drainage and service strings. The minimum clearance may be less than the vertical clearance if the drainage or services are on very steep slopes.

To view parallel services, add the services model onto a section view, profile a drainage string and then set the corridor value for the section view.

Settings->Corridor and then set the Width left and Width Right to the desired clearance. If the service can be seen then it is within the tolerance. 11 is used in this example only so that you can see the service on the other side of the road.

Use the Next and Prev button to switch drainage strings.
To obtain a report of all strings inside or crossing the drainage string profiled, select the **View menu** button then **Utilities->Report**.

1. Select the **Global** tab
2. Select **Utilities Model** tab
3. Type **services** to create a new services file.
4. Select **Open** from the icon list.
In the **Service model** column **RB** to select the model. Enter **Minimum Clearance** for the services in this model. Include an extra amount for the thickness of the drainage pipe. If the service model contains other drainage/sewer strings you must add the thickness of these pipes as well.

If different clearances are required for different services then place the services in different models. Warnings will be issued when you **Regrade Pipes, Set Pit details, Import or Storm Analysis**. Cover levels or fixed inverts can be used to avoid the services.

To quickly move to the section view of the string, Double click on the message in the output window (note the red! mark). The **DNE** will move to the pipe and with auto profile button enables the section view will update to this string.

The most common method to avoid the clash is to increase the **Pipe cover limit** for this pipe segment so that the pipe is pushed down.

If the clash problem is above the pipe then the **Max pipe height** may be used and multiple pipes are selected.

This method is preferred over locking the inverts as this leaves more flexibility for aligning the inverts.

Often changing the **Grade mode** to **Min grade** on a branch line will raise the downstream invert. This may allow the entire trunk line to rise and thus reduce excavation costs. This is especially true if the service clash is near the upstream end of the pipe.
Once the invert levels have been reset by selecting **Regrade pipes**, the output window will indicate the final clearance.

After a pipe design run in **Storm Analysis**, details of the service clash data will again be listed in the output window.
18. Drainage Plan Plots

The drainage plan plots create detailed drawings with symbols for the pits, linestyles for the pipes and string names ready to export to the desired layers in CAD. Pipes levels are 3d and setout points ready for downloading to survey total stations are prepared.

18.1 Labelling the Pits and Pipes

Plan plots are used to label the pits and the pipes. Drainage Plan Annotations may be accessed from one of three locations. The third is the most common.

**Location 1:** From the plan toolbar

![Plan toolbar](image1)

Select the plot button and then Drainage plan

1. Select a ppf file from the library
2. LB Read
3. Select your drainage model
4. Type a model name for the new labels.
5. Select Plot
6. Select Finish

![Drainage Plan Plot PPF Editor](image2)

Now add the drainage labels model onto the plan view.

**Location 2:** The Plot Button on the Drainage Network Editor

The following panel will be displayed. This option can plot both the long section and plan at the same time. Select a ppf file from the library (drainage_design).
1. Enter a model for the plan annotations.
2. Select **Full clean model beforehand** if you have not manually moved any of your manhole labels.
3. Turn off the long section plot for now.
4. Select **Plot**.
5. Select **Back to Editor**
6. Now add the **Model for plan annotations** onto the plan view.
7. Note: if you rename the manholes you will need to replot these labels!

**Note that Full clean of model beforehand was not selected. The drainage plan plot does a smart clean where it deletes and reprints text that has not been manually moved and updates text that has been moved.**

The text properties can all be customised using the plot parameter file but this will be discussed later in the plotting section. These labels are not automatically updated when you change the names or pipe diameters. You must rerun the plot routine to update the labels.

### 18.1.1 Turn off View Text Pit Labels

To turn off the automatic view text pit labels for this view select Toggle=>Text and then walk right to select the drainage model. Do not click on Text, rather walk right. If you click Text you will toggle on/off all of your text on the view, not just the drainage model.
18.1.2 Moving Text

The labels created may be manually moved using the CAD toolbar but if the model is relabelled the text will return to its original location! Text moved via the Drafting->Multi string translate will remain in the moved position when Smart Clean is selected in the Plan Annotation panel.

Before selecting text turn on your **teXt snap.**

To move a single line of text use the CAD toolbar. Select the **Move text justify** button. To use this toolbar you must **DRAG** the Create text button to the right

and then release when the pointer is on the **Move Text Justify Point.**

To move a pre-defined **Group** of text select
Drafting->Multi string translate

Select **Group** and then pick and accept one of the text items in the group. Move it to its new location and accept.
19. Construction Setout

Pits are setout on the construction site using a variety of techniques. The DNE creates a construction setout point \((x,y,z)\) that can either be located at the pit centre or the pit centre can be dropped perpendicularly onto a design string for the \(xy\) location. The \(z\) value for the setout point has a number of modes as described below. Road centre line chainage may also be calculated.

In the diagram below the setout point is lip of kerb. The setout \(x,y\) location level \(z\) will be obtained from the setout string and the pipe will be shown at its proper position so that the pipe cover is calculated correctly.

Pipes are setout using the pit connection points and the invert levels.

**Design->Drainage-Sewer->Convert to Pts and Lines** will create 12d super strings with the pipe attributes on them.

Setout reports can be created and the drainage plan plot generates strings for the surveyor to download to the instruments.
19.1 Pit Setout (xy)

There are currently 9 modes for determining the pit setout levels.

**Cover RL** - this ensures the level is the same as the Cover RL (not available for Cover level).

**FS tin** - the level is obtained from the finished surface tin at the pit centre.

**NS tin** - the level is obtained from the existing surface tin at the pit centre.

**Setout String** - the pit centre is dropped perpendicular onto the setout string and the level is obtained from the elevation on the string.

**Sz + Setout String** - an offset is added to the level from Setout string described above.

**Max Obvert** - all connecting pipes, usually open channels, are checked for the highest obvert.

**DS Invert** - the invert of the outlet pipe (there is only one).

**Sump Invert** - the lowest pipe invert plus the Sump offset.

**Manual** - the user must manually type in the cover levels (rarely used as a default).

Explicit settings for the setout strings and the auto calculated values are found on the **Pit-Setout** tab. If the manual mode is selected the Easting and Northing locations may be picked in plan view or typed into the input boxes.

19.2 Pit Setout (z) Level

The setout level defines the level to be printed in the pit setout tables and in the drainage longsection plots. The **FS Tin** selection obtains the level from the FS tin, specified on the **Global-Main** tab, at the centre point of the pit. The **Setout String** location obtains the z level from the setout string as described in the section above. Explicit settings and the auto calculated value are found on the **Pit-Setout** tab.

19.3 Road Centre Line Chainage

If **Road chainage mode** is set to Centre string, then the **Centre String ID** in the Road design file (shown above) is used to select the road string to measure the chainage and offset from. The values and explicit settings for the road chainage and offset are found on the **Pit->Setout** tab.

19.4 Pipe Setout

Pipe setout is along the centre line of pipes.
19.5 Plan Plots for Surveyors

Use the drainage plan plot routine to create survey setout point for each pit and strings for each pipe with the invert levels. If `drainage_setout` is not in your library, start with `drainage_inverts`.

1. Select `drainage_setout` ppf from the library
2. LB Read
3. LB Drainage Plan Plot branch
4. Select the existing drainage model
5. ensure NOT selected
6. Select Pipes branch and note Trim mode
7. Select Maintenance holes->MH setout points branch
8. Note: Draw setout points is selected.
9. String names are sent to the survey instruments so select this.
10. Select Plot
11. Add `drainage_setout` model onto a plan view

This routine does not recalculate the setout locations. Similar to plotting, it prints the results of the last time the calculation were done (DNE->Set Pit Details).

Position of option on menu: Design => Drainage => Reports => Pit schedule

This routine prints the calculations from the last time Set Pit Details was selected in the Drainage Network Editor.

On selecting the Pit schedule option, the Manhole/Pit Schedule panel is displayed.
The fields and buttons used in this panel have the following functions.

### Field Description

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Type</th>
<th>Defaults</th>
<th>Pop-Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drainage model name</td>
<td>input box</td>
<td>drainage network</td>
<td>drainage strings</td>
</tr>
<tr>
<td>Pit schedule file name</td>
<td>input box</td>
<td>pit report</td>
<td>file to be created</td>
</tr>
<tr>
<td>Report Format</td>
<td>choice box</td>
<td>Road change, Easting...</td>
<td>file format</td>
</tr>
<tr>
<td>Data delimiter</td>
<td>choice box</td>
<td>Tab, Space</td>
<td>tab delimiters are best for spreadsheets and space for some text editors</td>
</tr>
<tr>
<td>Repeat header for each line</td>
<td>tick box</td>
<td>selected</td>
<td>when selected, the column headings will be printed each drainage line</td>
</tr>
<tr>
<td>Process</td>
<td>button</td>
<td>Create the pit report</td>
<td></td>
</tr>
<tr>
<td>Finish</td>
<td>button</td>
<td>remove the panel from the screen</td>
<td></td>
</tr>
</tbody>
</table>

### Notes:

The columns of data may be separated by spaces or a tab (tab is used for spreadsheet transfers). The internal width and length data are retrieved from the drainage.4d file for the pit type specified. If you want a longer description for the pit then the type used inside 12d this can also be entered in the drainage.4d file. The remarks for each pit are entered as user defined pit attribute named remarks and may be set using the attribute editor (on the drainage menu) or via a spreadsheet.

### Easting Northing Sample

<table>
<thead>
<tr>
<th>Pit Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>B1</td>
</tr>
<tr>
<td>A2</td>
</tr>
<tr>
<td>C1</td>
</tr>
<tr>
<td>A3</td>
</tr>
<tr>
<td>A1</td>
</tr>
</tbody>
</table>
NOTE:
1. ALL SETOUT POINTS QUOTED TO CENTRE OF PIT

Road Chainage Offset Example

<table>
<thead>
<tr>
<th>DRAINAGE LINE A</th>
<th>PIT LOCATION</th>
<th>LOCATION OFFSETS</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIT No.</td>
<td>EASTING</td>
<td>NORTHING</td>
</tr>
<tr>
<td>A/1</td>
<td>5354.629</td>
<td>7336.936</td>
</tr>
<tr>
<td>A/2</td>
<td>5340.691</td>
<td>7320.811</td>
</tr>
<tr>
<td>A/3</td>
<td>5293.458</td>
<td>7320.886</td>
</tr>
<tr>
<td>A/4</td>
<td>5250.131</td>
<td>7320.886</td>
</tr>
<tr>
<td>A/5</td>
<td>5217.194</td>
<td>7322.036</td>
</tr>
<tr>
<td>A/6</td>
<td>5183.458</td>
<td>7322.036</td>
</tr>
<tr>
<td>A/7</td>
<td>5152.699</td>
<td>7322.036</td>
</tr>
</tbody>
</table>

Notes

The Set pit details must be run at least once to before printing the report. If the pits are moved or the designed strings changed then this option must be rerun.

The easting northing data obtained for the road design string option is obtained by dropping the pit centre perpendicular onto the selected road design string. This data is stored as pit attributes setout x and setout y. It is calculated when the Set Pit Details is selected in the Drainage Network editor.
20. DNE and Rational Hydrology

The rational methods use the formula \( Q = CIA/360 \)
where

\[ \begin{align*}
A &= \text{catchment area (hectares)} \\
C &= \text{runoff coefficient} \\
I &= \text{rainfall intensity (mm/hr)} \\
360 &= \text{conversion factor to m}^3/\text{s for area (ha) and rainfall (mm/hr)}
\end{align*} \]

The rainfall intensity requires the input/calculation of the time of concentration \((tc)\) for the catchment and then a return period to be used in the IFD table (see 12d Rational Method Hydrology - Drainage, Rainfall Editor).

The total area entered/measured may be split into impervious and pervious and analysed separately.

If you use a single composite \( C \) value for your catchments, enter a \( %\) of impervious of zero and ignore the impervious settings.

Many authorities increase the \( C \) values for major storms. If you do not then enter the same \( C \) for minor and major. Similarly \( Tc \) values are sometimes reduced for major storms so you have the option to enter a minor and major \( C \) value. An example is provided below.

Total Area = 0.1
\( %\)imp = 80
\( C \)minor \( C \)major \( Tc \)minor \( Tc \)major

<table>
<thead>
<tr>
<th></th>
<th>Impervious Area*( %)imp</th>
<th>Pervious Area-Imp area</th>
<th>( C )minor</th>
<th>( C )major</th>
<th>( Tc )minor</th>
<th>( Tc )major</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.9</td>
<td>0.3</td>
<td>0.92</td>
<td>0.31</td>
<td>5 min</td>
<td>10 min</td>
</tr>
</tbody>
</table>

20.1 Network Editor - Global, Default Settings and Explicit Settings

This section will discuss the Global, Defaults and explicit setting for the hydrology parameters. Design values for the hydrology and hydraulics calculations are set

- either globally (one value for the entire network)
- or via defaults.

Defaults values may be overridden by explicit settings found on the top level catchment, pits or pipes tabs. Explicit over ride catchment settings need only be specified if the default value is not desired. Only fill them in if you want to use a value different than the default. The tool tip will indicate the default values.

Default values must be entered for all of the fields for Set 1. Set 2 and Set 3 blank default values will use the defaults you have used in Set 1.

20.1.1 Catchment Areas and Percent Impervious

There is no default catchment area to apply to all catchments. You may type in the catchment area or create a string where 12d will measure the plan area (Drawing Catchment Strings in 12d).

The percent impervious will split the catchment area into the pervious and impervious sub catchments. Separate \( C \) and \( Tc \) values are used for the pervious and impervious areas. The default percent impervious for the various sets are entered on the Defaults->Catchment Defaults tab and the explicit settings are on the Catchment tab. The percent impervious is used also used to determine the composite \( C \) value if using the ARR 1987 method for calculating runoff coefficients.
20.1.2 Coefficients of Runoff

**Global Settings**

Runoff C methods include Direct, Direct * Fy, ARR 1987, QUDM 2007 and ACT.

**Direct:** There is a global impervious C value for minor and major storms. This can only be set once. The C values for the pervious areas may be changed for every catchment in your model.

**Direct * Fy:** For urban areas in Australia the flood frequency factors (fy) are constant for urban hydrology. You are required to enter the f10 values, the same value for minor and major. For rural areas the direct method is required.

**ARR 1987:** The composite C value is calculated using the 1hr-10yr intensity, the percent impervious, ARR frequency factors and the return period specified when hydrology runs are made. **You must enter the 1hr-10yr intensity value. No C values are entered if this method is used!**

**QUDM 2007:** Similar to the ARR 1987 method (except when the %impervious for the catchment = 0.0). The Veg/Soil type must be entered for the catchment via the default catchment tab.
Explicit Settings

20.1.3 Times of Concentration
There are several methods for entering times of concentration for the catchment areas (see list below). Since each catchment may use a different tc method, all of the tc parameter fields on the defaults tab are active and required. They must be filled in even if you do not plan on using that value.

1. **Direct method** requires minor and major tc values.
2. **Friend, Kinematic Wave, Bransby Williams** and QDUM methods require the retardance, length and slope of the catchments to be entered. Default values must be entered but the optional explicit settings for slope and length can be entered on the catchment tabs or a catchment characteristic strings may be drawn (see Catchment Tc path strings). The length of this string is used for the length parameter and the design tin is used with the string to calculate the slope using the equal area method.
3. Data for the remaining methods is entered in a similar fashion.

20.2 Catchment Areas

**Key Points**

1. You do not have to draw catchment strings. You can enter the catchment areas manually (ha or acres).
2. When drawing catchment polygons, start near the inlet for auto linking.
3. 3 catchment sets are available and all catchment polygons must be in these models.
5. Network Editor Set Catchment button links the polygons and calculates the areas
6. Once a string has been linked to a inlet, it will remain linked until it is deleted or the link has been cleared (Clear Catchment Links on the Globals->Utility Models tab).
8. Manholes (set via cap_config in drainage.4d or Inlet config on the Pit->Main tab cannot have linked catchments.
9. Use the CAD polygon tool for drawing catchments OR close the string for sag pits
10. You can disable the auto selection of a string via Right mouse on the pick button then select Clear.

The catchment strings may be drawn in a CAD package and then imported into 12d or drawn inside 12d. The strings may be easily drawn in 12d with the tin contours and/or flow arrows displayed in the plan view.

When a catchment string is created to define the area for an inlet then all other data entry types will be ignored and the area from the string will be used.

There are 3 sets of catchments and it is up to the user to decide how they are to be used. Each set has its own percent impervious. The most common is to use the sets as land use types (roads, lots and park land for example). Another frequently used option is to use set 1 for all the impervious areas and set 2 the pervious and set 3 for special areas. The 3 catchment sets are drawn in three different models.

If exporting to external drainage design programs, the package may not accept all three sets so check the interface notes before defining the catchments.

Set Catchments - Auto Linking

In each set/model, 12d will automatically link the catchment string to the inlet that is closest to vertex 1 on your catchment string. This is the preferred method. If this is not possible, then an inlet may be manually linked to a catchment string using the Catchment manual link. More on catchment links may be found in Catchment string links.

Also see Checking the Automatic Catchment Linking

Start the Drainage network editor and move to the Global Tab and then the Utility Models sub tab.
The Auto-rename catchment polygons will set the name of the catchment string to the pit name that it is linked to. If it is not linked to any inlet it will be named “not used”. The model can be checked for not used strings by selecting Models->String Info Table. The catchment will also be filled with the Error colour if a catchment string is not linked.

1. Type a filename for the catchment file
2. LB More info button and then select Open
3. RB to select the catchment model for set 1 (used in the CAD control bar above). Every inlet can have up to 3 catchments, row 1 is catchment set 1, row 2 for catchment set 2 and row 3 for catchment set 3. Often the sets are used as catchment types. for example Set 1 - Roads, Set 2 Lots and Set 3 Parks
4. Optional - RB to select a fill colour for the catchments
5. LB Write to save the file
6. LB Finish
7. Type a new model name for the catchment labels (optional)
8. LB More info button to select textstyle (required if Labels model is used)
Label Catchments

There are some cases where linking the closest inlet to vertex 1 is not feasible. In these cases you may manually link the inlet to a catchment.

20.3 Drawing Catchment Strings in 12d

There are 2 catchments on the south east side of the road that have not be drawn. Use the CAD polygon tool to draw the catchments.

Before creating the catchment string set the CAD control bar data.

Finally select Set catchments. This will link the catchments to the inlets and label the catchments. Now add the mode labels onto the plan view.

Adding the edges to the fills

To view the edges go to the View Menu button and select Settings->Faces

1. LB Draw Edges
2. LB Set
3. LB Finish

There are some cases where linking the closest inlet to vertex 1 is not feasible. In these cases you may manually link the inlet to a catchment.
Type the name of a model for the catchment strings

Now to create the catchment string use the **Create line string** button on the CAD toolbar.

**DRAG** the **Create line** button and release at the **Create Line String** button.

The first point should always be placed near the inlet. 12d will assume that the catchment will drain to the inlet closest to this first point.

Draw the catchment strings with the accuracy you feel appropriate. Catchment strings for sag pit or drawn along a crest lines so take extra care near the crest low points where the water may overflow and bypass. Continue selecting and accepting the points on the catchment string and the press **ESC** to finish creating this string. You are now ready to create the next catchment string.

**Sag inlet catchments:** **DO NOT START AT THE INLET, just start nearer to this inlet than any other!** If you start at the inlet then move out to the crest of the catchment, the catchment overflow level cannot be determined from the catchment string.

**CAD tips**

Use the CAD toolbar eye dropper to load the properties from an existing catchment polygon.

Try CAD trace instead of CAD polygon to trace around edges of existing catchment areas. It is at the end of the CAD string fly out. Follow the directions in the 12d message area (bottom left of window).

Trace begins as normal string draw, select t to start the trace, pick the start point on a string then pick the end point of the trace, (if the trace is going the wrong way select f or b).

Now you can select another string to trace or select p to return to pick mode.

select c to close and finish and you are off creating another catchment string.

Once the catchments are drawn they become linked to the drainage network in the **Drainage network editor**. We will label the catchment with the inlet name and area at the same time.
20.4 Splitting Catchment Strings to Insert an Inlet

The catchment for the northwest sag pit needs to be split into 2 catchments for the inlet labelled I-9. We will use mostly CAD tools except for Strings->Strings edit->Split. The trick is to roll the mouse roller ball once whenever you need to redraw the screen.

1. Cad String->Close to close the string. (roller ball!)
2. Strings->Strings Edit->Split, select string at split point (string area will go solid white - accept) roller ball!
3. repeat for south side
4. CAD vertex->Append select the string away from the split point, roller ball and draw the new catchment boundary. Single ESC to finish this string.
5. CAD vertex->Append select the string away from the split point, roller ball and trace the new catchment boundary. Double ESC to finish this string and end appending

Catchment manual link

The manual links are used when the first point on the catchment string is closest to the wrong inlet. Note that the following restrictions still apply.

1. The string selected for catchment 1 must be in the model for set 1. To check if you have selected a valid string select the Set Catchments button.
2. If the catchment string has already been linked to another inlet (automatic or manual) then the new link will be created and the old link erased.
3. If you change the catchment model for one of the sets on the Network Editor->Global->Utility Models->catchments than all of the manual links in that set will be erased.
1. Change to the **Catchment** tab. Move to the desired inlet, I-9 in the plan above. The inlet will be circled in the plan view and its name shown in the **Current Pit** field.

2. LB Set 1 then LB the **Catchment polygon** button and pick the desired catchment string.  
   **NOTE!** If you decide to enter a value and NOT use the selected string RB on the button and select **Clear**.  
   If the **Auto apply** tick box is not selected then you will have to select the **Apply** button for the manual link to become active.

3. LB **Set Catchments** button. A prompt box appears asking you to confirm. Select **Yes**. To toggle off/on the confirm request RB **Set Catchments**. The measured catchment area will be shown in the **Catchment area** field using the units specified in the **Global-Utility models-Units** field.

4. Repeat these steps for the sag pit to the west.

**Verifying the Automatic Catchment Linking**

The automatic inlet-catchment linking is easily checked by after selecting the **Set Catchments** button on the network editor by any or all of the following:

1. Specifying a **Catchment labels model** with **Labels textstyle** on the **Global->Utility models** tab and .  
   The catchment is indicated when the inlet is selected using the network editor. Since there may be three catchments per inlet the catchment data last viewed in the editor is the catchment that is highlighted.

2. Selecting the **Auto-rename catchment polygons** on the **Global->Utility Models** tab will set the name of the catchment string to the pit name that it is linked to. If it is not linked to any inlet, it will be named “not used”. The model can be checked for **not used** strings by selecting **Models->String Info Table**.

3. The unlinked catchment strings will be filled with the **Error colour** on the **Global->Utility models** tab.
Reseting All Catchment links to Start Over

There may be occasions where you will want to clear all of the catchment links and begin with a fresh start. Select Clear Catchment Links on Network Editor->Global->Utility Models.

20.5 Tc Path Strings

These strings are used to calculate the time of concentration for the impervious and pervious areas. For each catchment set, they are drawn in two models; one for the impervious paths and one for pervious paths. The models are specified using the Catchment file field on the network editor (Global->Utility model tab). The 3 rows in the catchment file correspond to the 3 catchments available for each inlet. Therefore it is possible to have a maximum of 6 Tc paths models!

Key Points

1. Each Catchment set may have 2 Tc paths models. Pervious and impervious paths are kept in separate models.
2. End the Tc path string near the inlet that it is to be linked to.
3. Enter the paths models via Catchment file field on the (Global->Utility model tab)
4. You must select a Tc method (explicit or implicit) via the Defaults->Catchments tab or the Catchments Tabs. Just specifying the models is NOT enough!
5. Select Set Catchments to perform the calculations of length and slope.

The tc strings can be drawn in the same way as the catchment strings but make sure that you change the model name first! The tc string model is then entered in either the impervious or pervious paths model columns (You could have up to 6 tc string models!).
20.5.1 Catchment slope (equal area)

The length of this string is used for the length parameter and the design tin is used with the string to calculate the slope using the equal area method. These strings are drawn from upstream to downstream, finishing nearest to the inlet they are to be linked to.

1. Change the Cad toolbar model to `dr Catch Reserve tc` and the line type to FLOW LINE
2. Use Cad line->Cad line to draw the flow path from the culvert inlet up to the top of the catchment.
3. Use Cad string->Reverse to that the string is in the same direction as the flow.
The equal area slope is calculated when **Set Catchments** is selected. The slope string be profiled, with tin combined added to the view, to see the slope and the equal areas (see below) above and belong the tin.
21. Network Editor - Hydraulics

This section will discuss the hydraulic Global, Defaults and explicit settings for the hydraulic parameters. The explicit settings for the parameters described on the defaults tab will also be found on the Pit or Pipe tabs.

21.1 Grate Levels

**Important!** Get the Grate level correct! The freeboard is measured from this level and if you do bypass calcs the water will bypass if the hgl reaches this level. If the grate level is at or below the obvert of the pipe then the pit cannot surcharge and the pipe cannot flow full (it is an open channel). The grate level should not exceed the cover level except for pressurised, bolt down manholes and culvert headwalls.

**Special Structures**

- **Bolt down manholes** will have the grate level above the cover level. The height above the cover will determine the hydraulic head required to "pop" the cover off and begin surcharging.
- **Headwalls** cover levels are often the top of the headwall structure and the grate level is set to the highest point of the channel before bypass begins.

21.2 Outlet and Tailwater Conditions

The most downstream pit on each network requires tailwater conditions. Often the invert level on the downstream end of the last pipe also needs to have the invert level locked to either discharge into a waterway or join into an existing drainage system. When the most downstream pit is selected the following fields will become active on the DNE Pit-Main tab. If these field are not active and you think you are at the outlet see Flow in the Wrong Direction.

**Minimum** will use the least of the Critical or Normal depths. If a fixed level is available for the minor and/or major storms, these value may be entered here.

The **Ko** is the loss coefficient for the exit losses into the downstream system. A value of 1 is typical for discharging into a pond or creek, or a Ku value for the pipe configuration in the pit the network is joining.

21.3 Culvert Hydraulics and Tailwater

To set the tailwater conditions for the culvert we created at the beginning of the course, select the outlet
In part 2 of the course we add an open channel to calculate a realistic tailwater for the culvert.

### 21.4 Pit Losses Ku, and Direct Flow

The $Q_{dg}$ (direct flow) (cms/cfs) is water flowing into the manhole. It is added to the approach flow and is subject to pit inlet capacity. This field will be disabled on the pit tab if the inlet type is set to a manhole.
The **Pit loss Ku** is used to model the energy losses through the pits and inlet control on culvert inlets. Three Ku methods are available, **Direct** (user entered), **Ku,Kw via charts** (may be negative), or **Ku,Kw >0 via charts** where all negative values are changed to zero. The remaining methods specify various headwall types for culverts. These will use inlet control curves and backwater energy loss coefficients.

**Ku config** has 4 options: **Preferred**, **Good**, **Fair** and **Poor**. The settings have no effect for 100% grate flow, straight through and 90° bends. For pipes with bends they determine the charts to use. The following are guidelines in selecting the Ku config.

- **Preferred**: water impacts the opposite wall where it exits
- **Good**: water impacts the side wall where it exits
- **Fair**: water impacts the side wall and exits on the end
- **Poor**: water impacts the opposite wall of the pit and exits on the side wall.

### 21.5 Introduction to 12d Ku/Kw Calculations

The following description is a very general overview of the Ku calculations in 12d. For a detailed description please see the 12d forum site http://forums.12dmodel.com/.

When 12d uses the Ku and Kw Charts, the values of upstream pipe angle, (Qgrate/Qoutlet), (Upstream diameter/outlet diameter) and (pit depth/outlet diameter) are calculated and used in the Ku/Kw charts. Three cases exist which determine which chart is used.

**Case 1 - Pits with 100% Grate Flow**

The angle between the ground approach flow and the exit pipe is measured. Charts, compiled from Sangster et al (1958) are used; G1 is used for angles less than 15 degrees (rare) and G2 for angles > 15 degrees. 12d’s names G1 and G2 can be referenced to other publications in the table below.

**Case 2 - Pits with More than 50% Through Flow**

12d has 10 charts (T1-T10) compiled from the Hare (1981) and cross referenced to the QUDM and ACTDS Charts. In general T10 charts have greater losses than T1 charts.

**Ku Config**

<table>
<thead>
<tr>
<th>0°</th>
<th>22.5°</th>
<th>45°</th>
<th>67.5°</th>
<th>90°</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferred</td>
<td>T1</td>
<td>T2</td>
<td>T4</td>
<td>T8</td>
</tr>
<tr>
<td>Good</td>
<td>T1</td>
<td>T2</td>
<td>T5</td>
<td>T8</td>
</tr>
<tr>
<td>Fair</td>
<td>T1</td>
<td>T3</td>
<td>T6</td>
<td>T9</td>
</tr>
<tr>
<td>Poor</td>
<td>T1</td>
<td>T3</td>
<td>T7</td>
<td>T9</td>
</tr>
</tbody>
</table>

**12d Chart Cross References**

<table>
<thead>
<tr>
<th>12d Pit Config</th>
<th>G1</th>
<th>G2</th>
<th>T1</th>
<th>T2</th>
<th>T3</th>
<th>T4</th>
<th>T5</th>
<th>T6</th>
<th>T7</th>
<th>T8</th>
<th>T9</th>
<th>T10</th>
</tr>
</thead>
<tbody>
<tr>
<td>QUDM Ku Chart #</td>
<td>32</td>
<td>32</td>
<td>33</td>
<td>34</td>
<td>35</td>
<td>37</td>
<td>37</td>
<td>38</td>
<td>40</td>
<td>42</td>
<td>44</td>
<td>46</td>
</tr>
<tr>
<td>QUDM Kw Chart #</td>
<td>32</td>
<td>32</td>
<td>33</td>
<td>34</td>
<td>36</td>
<td>37</td>
<td>37</td>
<td>38</td>
<td>40</td>
<td>42</td>
<td>44</td>
<td>46</td>
</tr>
<tr>
<td>ACTDS Ku Chart #</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>13</td>
<td>14</td>
<td>10</td>
<td>9</td>
<td>16</td>
<td>18</td>
<td>20</td>
<td>22</td>
<td>7</td>
</tr>
<tr>
<td>ACTDS Kw Chart #</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>13</td>
<td>15</td>
<td>10</td>
<td>9</td>
<td>17</td>
<td>19</td>
<td>21</td>
<td>23</td>
<td>8</td>
</tr>
<tr>
<td>ACTDS Pit Type #</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>11</td>
<td>12</td>
<td>8</td>
<td>7</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>6</td>
</tr>
</tbody>
</table>

**Case 3 - Pits with between 0 and 50% Through Flow**

With the flow condition between grate flow and through flow, a K value interpolation is performed based on the percentage through flow.
21.6 Pipe Friction Method, Roughness Values and Direct pipe flow

The default roughness and pipe roughness method are set here (Colebrook (mm) or Manning).

\[ Q_{dp} \] (direct pipe flow is flow) at the upstream end of the pipe that is included in the pipe flow calculations but is not included in the upstream pit losses nor restricted by the pits inlet capacity.

The ranges for pipe peak velocities are used for checking purposes only. If the velocities are outside this range, warning messages will be given in the output window.

21.7 Design mode, Freeboard Limit and Flow-depth limit

The Design mode has 4 options.

Pressurised Pipe: Freeboard Design does not use partial depths in the pipes and pipe sizes selected by checking the pit freeboard.

Part-full Pipe: Freeboard Design is similar to option 1 except gradual varied flow and hydraulic jumps are calculated in the pipes. Critical depth is the minimum depth at the upstream end of the pipe.

Part-full Pipe: Flow-depth Design is the similar to option 2 except the pipe sizes are selected by checking the normal depth in the pipe against the Flow-depth limit. Freeboard is also checked in this mode and if required the pipe will increase in size.

Open Channel: Freeboard Design is similar to option 2 except depths at the upstream end of the pipe may be less than critical depth for steep pipes (supercritical flow at the entrance).

The Freeboard limit is used for all Design modes. The freeboard is measured down from the grate level (Cover RL plus Grate offset).

The Flow-depth limit at pipe entrance (%) is used in Design mode 3. If the flow depth in the pipe is
greater than this value the pipe size is increased.

21.8 Pipe Design Parameters - Sizes, Invert alignment, Min Cover, Max Height

The invert levels during design are controlled by the pipe sizes, max pipe height, min pipe cover and invert alignment mode.

21.9 Pipe sizes, Max pipe height and Multiple Pipes and Box Culverts

The 12d design engine will select pipe sizes from the file specified on the Drainage Network Design panel, Preferred pipes file field list. See selecting pipe sizes. However, the maximum pipe height allowed before multiple pipes are used and the selection of box culverts is set on the pipe->main and pipe >design tabs respectively.

Num of specifies the number of identical pipes. The pipe flow is divided by this value when calculating losses.

To specify a box section in your network, select the pipe and enter a width for the pipe.

A Top width is used for trapezoidal channels. Note that if the hgl exceeds the top of the channel it will have friction on the soffit just as a box culvert.

For box culverts, the design engine increases the widths and maintains the height through the available sizes. Once the maximum height has been reached, the next culvert height and minimum width is checked.
21.10 Pipe Size Design

On the Pipe tab the **Lock Pipe size** prevents the 12d design engine from resizing the pipe. **Min pipe height** can be set for each pipe segment (there is no default for this value).

Specifying a minimum pipe size may speed up 12d design. The starting value for pipe sizing will not be less than this value. That includes all downstream pipes as well. So if you know that the pipe needs to be this size or bigger, enter it here.

**Max pipe height** can be set for each pipe segment (there is no default for this value). If the 12d design engine requires a larger pipe, then multiple pipes will be selected.

21.11 Calculate Bypass flow routes

This option is required for pit inlet capacity calculations and is covered in the Stormwater Part 2 training. As an introduction, the bypass strings determine the downstream bypass inlet for each inlet. Inlet capacity is determined from commands in the drainage.4d file. Road grade and crossfall measurements require the inlet to be linked to a setout string and pond depth measurements require a link to catchment string.
22. Drainage Design in 12d Drainage Design

12d has a sophisticated rational method hydrology and hydraulic grade line pipe design engine. In addition it has the capability to export this data to several other popular drainage packages. Regardless of the design method selected, the drainage network in 12d is updated from the design so that drainage plans, long sections and pit schedules can be quickly produced.

22.1 12d Rational Method Hydrology - Drainage Rainfall Editor

The Drainage Rainfall Editor is used to input rainfall IFD data using several methods. The data is stored in hydro files (each file is for a specific location) that can be shared between 12d projects. The data is edited using an editor similar to those used for the plot parameter files (ppf). Seven methods for entering/calculating the rainfall intensities are shown in the panel below. From the main menu select, Design->Drainage-Sewer->Rainfall Editor Data is entered using one (or more if desired) input methods and then saved by entering a Meteorology file name and selecting Write. The standard 12d system file search paths are used (project folder, user library folder and then library folder).

Select the folder icon and then walk right on the Lib item to display a list of sample files. Select a file the select Read. YOU MUST SELECT THE READ BUTTON!

22.1.1 IFD Tables

IFD tables are often available from meteorological services. The table input format follows. The first row is used to define up to 9 return periods and the following rows list the rainfall intensities for the duration entered in the first column.

Hint: to increase the size of the grid control select another method, ARR 1987 for example, and then select IFD table again.
22.1.2 Australian Rainfall and Runoff 1987 Method
The rainfall intensities and other factors from Volume 2 of ARR 1987 are entered in this table.
22.1.3 Australian Rainfall and Runoff 1977 Method
The seven coefficients for each return period from ARR 1977 are entered in this table.

![Drainage Network Rainfall table](image)

22.2 Drainage Network Design
The **Storm Analysis** button on the **Network Editor** executes the 12d drainage design, plots the drainage long section and plan annotation and prepares the hydrology and hydraulic design tables.

![Drainage Network Design panel](image)

From the **Drainage Network Editor** select **Storm Analysis**. The following design panel will appear.
Storm Analysis Factors

The valid ARI will depend on the method selected but you cannot extrapolate beyond your data. Select the folder icon on the Rainfall location file and then walk right on the Lib line to select one of the rainfall files in the 12d library. If the file has only one type of rainfall definition then the Rainfall method field will be completed. Otherwise select the Rainfall method desired.

Storm event type determines which set of design values (minor or major) will be used for this run. Pipe travel time method should be set to the authorities requirements.

Enable the 12d rational method engine partial area calculations by selecting the Partial area effects box.

Network Design Factors

Modify Pipe Sizes

These values control the values to be designed in the run. Consider bypass flows causes the engine to use the bypass flow routes and inlet capacity data from the drainage.4d file.

Ensure Pipe Q < Qcap will increase the pipe size if this criteria is violated.

Modify pipe inverts will allow the design engine to shift the inverts if required (usually pipe size changes).

If Modify pipe sizes is selected then a file containing the available pipe sizes must be supplied. The pipe sizes in this file are in the Units specified in the drainage network editor. To create a new file, enter the file name and then select the folder icon followed by the Edit line. The following panel will appear.
The **Upsize only** selection will stop pipes in the system from being reduced in the design. Regardless of this selection, the 12d design engine will not allow a smaller pipe to be selected in the downstream direction.

### 22.3 Pipe Sizes too Large?

The hydraulic settings can change your pipe sizes. Check Grate levels, freeboard, pipe design criteria and read the notes below!

- A few comments on why you may have large pipes in your design.
- If one pipe is sized large then 12d will not allow a smaller pipe downstream. So when pipes seem large, check the most upstream large pipe. HGL restraints will require you to look downstream of the large pipe.
- **Check List**
  1. High roughness values, accidentally setting roughness to Manning with a 0.6 roughness value (Colebrook)!
  2. Grate levels not set correctly. Freeboard is measured from these levels.
  3. Pipe min pipe cover set very close to freeboard.
  4. Selecting **Ensure Q<Qcap** in the storm analysis dialogue. This is required by some authorities but can cause larger pipes in flat areas.
  5. NOT selecting **Modify pipe sizes** in the storm analysis dialogue. 12d will not change the pipe size.
  6. Selecting **Only allow pipes to upsize** in the storm analysis dialogue. 12d will not check if a smaller pipe will do.

#### Generate Results in Plan

This selection automatically runs the drainage plot annotation function. A **Drainage plan ppf** must be entered and samples are supplied in the 12d library. A **Model for plan results** is required if this option is selected. The **Full clean model before hand** tick box forces the model to be cleaned before the labels are created. When not selected a “Smart clean” is performed.

#### Generate Results in Long Section

This selection automatically runs the drainage long section plotter. A **Drainage long section ppf** is required and examples are found in the 12d library. A **Model stem for long section results** is required if this option is selected. In almost all cases the **Clean model before hand** tick box should be selected.
Generate hydrology report

22.4 The Run Button and HGL data on the Section View

When the **Run** button is selected the discharges are calculated, the HGL check is performed and the pipes sizes and inverts are designed (if selected). The plan and long section drawings will also be updated with the new data (if selected).

The HGL values will also be available on the 12d section views when profiling the drainage strings. The colour of the HGL line may be changed via the view’s menu button then **Settings->Drainage**.

22.5 Importing Text into a 12d model

Formatted text may be inserted into a 12d model by selecting **The hydrology report** may be formatted for inserting into a 12d model/text editor (formatted) or spreadsheet (comma or tab delimited). In almost all cases **Overwrite existing report file** will be selected.
Drafting->Text and Tables->Create edit paragraph text

Change to File.
Select the folder icon and then pick the formatted text file. It will be displayed then select Set.
Next select the location in plan for the text.
The font selected must be a fixed space font or the data will not align properly.

Select the Font to display the following panel.

Enter a Text Model for the report.
The Text Style must be a fixed space font.
Select Set then Finish.
Now add the Text Model onto the

The hydraulic report may be formatted for inserting into a 12d model/text editor (formatted) or spreadsheet (comma or tab delimited). In almost all cases Overwrite existing report file will be selected.

If you want both the hydrology and hydraulic report in the same file, enter the same file name in both file fields but turn of the Overwrite existing report file for the hydraulic report.
22.5.1 Design Results
Results from the design runs are shown in several forms:
1. Hydrology and hydraulic reports
2. Drainage plan annotations
3. Drainage long sections
4. Hydraulic Grade line on the Section view
5. Output window data - Service/utility clashes
Samples of the hydrology and hydraulics report are shown below.
12D MODEL - HYDROLOGICAL DESIGN SHEET

Project: Stormwater Part 1
Drainage Model: drainage
Location File: GLISSAUS OLD CENTRUS.13aug2020
To Methods: Direct
Rainfall Method: IDO Table
Runoff C Method: Direct

Minor 5 Year Storm Event

<table>
<thead>
<tr>
<th>Pit</th>
<th>Pit</th>
<th>Setout</th>
<th>Setout</th>
<th>Level</th>
<th>Catch ID</th>
<th>To</th>
<th>Intensity</th>
<th>Runoff C</th>
<th>Area</th>
<th>Pull</th>
<th>Pull</th>
<th>Pull</th>
<th>Partial</th>
<th>Partial</th>
<th>Partial</th>
<th>Approach</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>A2</td>
<td>5305.23</td>
<td>7322.04</td>
<td>30.09</td>
<td>1P</td>
<td>10.00</td>
<td>0.75</td>
<td>0.0083</td>
<td>0.0062</td>
<td>0.0732</td>
<td>35.1</td>
<td>0.0031</td>
<td>0.0701</td>
<td>39.7</td>
<td>39.7</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>A2</td>
<td>5303.31</td>
<td>7322.04</td>
<td>29.08</td>
<td>1P</td>
<td>10.00</td>
<td>0.75</td>
<td>0.0059</td>
<td>0.0044</td>
<td>0.0632</td>
<td>23.7</td>
<td>0.0032</td>
<td>0.0508</td>
<td>28.4</td>
<td>28.4</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>A2</td>
<td>5206.65</td>
<td>7322.04</td>
<td>27.09</td>
<td>1P</td>
<td>10.00</td>
<td>0.75</td>
<td>0.0052</td>
<td>0.0040</td>
<td>0.0470</td>
<td>21.3</td>
<td>0.0025</td>
<td>0.0451</td>
<td>26.5</td>
<td>26.5</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A2</td>
<td>5198.75</td>
<td>7322.04</td>
<td>26.78</td>
<td>1P</td>
<td>10.00</td>
<td>0.75</td>
<td>0.0051</td>
<td>0.0046</td>
<td>0.0486</td>
<td>21.3</td>
<td>0.0025</td>
<td>0.0451</td>
<td>26.5</td>
<td>26.5</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>A2</td>
<td>5319.17</td>
<td>7336.94</td>
<td>25.32</td>
<td>1P</td>
<td>10.00</td>
<td>0.75</td>
<td>0.0051</td>
<td>0.0046</td>
<td>0.0486</td>
<td>207.6</td>
<td>0.0124</td>
<td>0.4322</td>
<td>248.9</td>
<td>248.9</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>A2</td>
<td>5296.19</td>
<td>7336.94</td>
<td>28.49</td>
<td>1P</td>
<td>10.00</td>
<td>0.75</td>
<td>0.0051</td>
<td>0.0046</td>
<td>0.0486</td>
<td>73.8</td>
<td>0.0069</td>
<td>0.1562</td>
<td>88.5</td>
<td>88.5</td>
<td></td>
</tr>
</tbody>
</table>
### Stormwater Design Part 1

**1D Model - Hydraulic Design Sheet**

**Project:** Stormwater Part 1  
**Subsurface:**  
**Location File:**   
**Rainfall Method:** SSD Table  
**Pipe Cover Limit:**  1.8  
** Manning n Roughness:**  0.01  
**Freeboard Limit:**  0.2

#### Manor 5 Year Storm Event

<table>
<thead>
<tr>
<th>ID</th>
<th>(-)</th>
<th>(-)</th>
<th>100.0</th>
<th>(-)</th>
<th>(-)</th>
<th>100.0</th>
<th>(-)</th>
<th>100.0</th>
<th>(-)</th>
<th>100.0</th>
<th>(-)</th>
<th>100.0</th>
<th>(-)</th>
<th>100.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 2</td>
<td>2</td>
<td>49.98</td>
<td>300</td>
<td>0.971</td>
<td>2.16</td>
<td>44.6</td>
<td>10.00</td>
<td>143.00</td>
<td>0.0827</td>
<td>0.9732</td>
<td>33.1</td>
<td>5.09</td>
<td>204.90</td>
<td>0.0794</td>
</tr>
<tr>
<td>2 to 3</td>
<td>3</td>
<td>34.65</td>
<td>400</td>
<td>0.169</td>
<td>2.16</td>
<td>44.6</td>
<td>10.37</td>
<td>140.79</td>
<td>0.0820</td>
<td>0.9941</td>
<td>286.9</td>
<td>5.11</td>
<td>220.86</td>
<td>0.0226</td>
</tr>
<tr>
<td>3 to 4</td>
<td>2</td>
<td>49.91</td>
<td>400</td>
<td>0.169</td>
<td>2.16</td>
<td>44.6</td>
<td>10.63</td>
<td>149.24</td>
<td>0.0873</td>
<td>0.7992</td>
<td>381.3</td>
<td>6.37</td>
<td>220.19</td>
<td>0.0831</td>
</tr>
<tr>
<td>4 to 5</td>
<td>2</td>
<td>10.44</td>
<td>400</td>
<td>0.169</td>
<td>1.22</td>
<td>82.0</td>
<td>10.00</td>
<td>142.00</td>
<td>0.0162</td>
<td>0.4586</td>
<td>207.6</td>
<td>5.08</td>
<td>204.80</td>
<td>0.0493</td>
</tr>
<tr>
<td>5 to 6</td>
<td>3</td>
<td>91.21</td>
<td>500</td>
<td>0.871</td>
<td>1.60</td>
<td>55.9</td>
<td>10.00</td>
<td>142.00</td>
<td>0.0200</td>
<td>0.1652</td>
<td>73.9</td>
<td>5.09</td>
<td>204.90</td>
<td>0.0751</td>
</tr>
</tbody>
</table>

#### Pipe Design

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 2</td>
<td>32.7</td>
<td>383.2</td>
<td>0.22</td>
<td>0.56</td>
<td>2.08</td>
<td>1.98</td>
<td>2.53</td>
<td>36.98</td>
<td>50.95</td>
<td>27.95</td>
<td>25.98</td>
<td>21.10</td>
<td>6.0</td>
<td>9.17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 to 3</td>
<td>31.2</td>
<td>444.4</td>
<td>0.18</td>
<td>1.97</td>
<td>3.04</td>
<td>2.11</td>
<td>3.42</td>
<td>29.80</td>
<td>27.32</td>
<td>26.24</td>
<td>27.08</td>
<td>1.10</td>
<td>6.0</td>
<td>0.24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 to 4</td>
<td>421.4</td>
<td>544.0</td>
<td>0.77</td>
<td>2.65</td>
<td>3.78</td>
<td>2.71</td>
<td>3.42</td>
<td>27.98</td>
<td>25.32</td>
<td>25.24</td>
<td>26.78</td>
<td>1.10</td>
<td>6.0</td>
<td>0.24</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 to 5</td>
<td>240.7</td>
<td>493.5</td>
<td>0.61</td>
<td>1.56</td>
<td>2.70</td>
<td>1.37</td>
<td>2.57</td>
<td>25.32</td>
<td>27.80</td>
<td>27.58</td>
<td>24.08</td>
<td>1.10</td>
<td>52.9</td>
<td>0.656</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 to 6</td>
<td>88.9</td>
<td>373.3</td>
<td>0.81</td>
<td>1.24</td>
<td>2.45</td>
<td>1.51</td>
<td>2.44</td>
<td>28.49</td>
<td>27.10</td>
<td>26.81</td>
<td>27.98</td>
<td>1.10</td>
<td>28.4</td>
<td>0.196</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Pipe US Fit P'head Loss

<table>
<thead>
<tr>
<th>ID</th>
<th>Ku (Ku')</th>
<th>T'head Loss</th>
<th>NOL US</th>
<th>DOL CC</th>
<th>NOL US</th>
<th>NOL CC</th>
<th>Grade US</th>
<th>US</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 to 2</td>
<td>2.00</td>
<td>0.03</td>
<td>0.82</td>
<td>25.04</td>
<td>25.88</td>
<td>28.37</td>
<td>28.37</td>
<td>1.14</td>
</tr>
<tr>
<td>2 to 3</td>
<td>2.00</td>
<td>0.40</td>
<td>0.89</td>
<td>28.37</td>
<td>27.97</td>
<td>27.48</td>
<td>27.48</td>
<td>0.89</td>
</tr>
<tr>
<td>3 to 4</td>
<td>2.00</td>
<td>0.72</td>
<td>0.82</td>
<td>27.48</td>
<td>26.77</td>
<td>25.54</td>
<td>25.54</td>
<td>2.46</td>
</tr>
<tr>
<td>4 to 5</td>
<td>2.00</td>
<td>0.25</td>
<td>0.80</td>
<td>25.70</td>
<td>25.45</td>
<td>25.37</td>
<td>25.37</td>
<td>0.45</td>
</tr>
<tr>
<td>5 to 6</td>
<td>2.00</td>
<td>0.16</td>
<td>0.15</td>
<td>27.80</td>
<td>27.84</td>
<td>27.48</td>
<td>27.48</td>
<td>0.50</td>
</tr>
</tbody>
</table>
23. Create a Drainage Model Template (Saving Defaults and Globals)

A drainage model template contains your favourite global and default settings for the DNE. These settings are stored as model attributes and the template may be read before or after the drainage strings have been created. Caution: existing default and global setting may be overridden.

You can create your own templates as well. Now that you have completed a drainage job and all of your global and default settings are set, create a template to save in your user library.

From the main menu select

Design => Drainage-Sewer => Create => Create/Read template

1. Change to Write.
2. Select drainage for your existing network
3. LB the folder icon, then user_lib, type a name for the template the select Open
4. LB Process to create the drainage model template for your next project.
24. Drainage Data Input and Output to Spreadsheets

Spreadsheets are an effective method to manage the numerous variables urban drainage designers create in the modelling process. Spreadsheet data can be transferred to and from 12d in tab delimited files and stored within 12d as “user definable attributes”. These attributes are linked to the pit and pipes within a network. Drainage long section plots can display the pipe attributes in the “arrows” data area and pit attributes in the bubbles area. Drainage plan drawing can also show these pit and pipe attributes.

Drainage strings will be created if they do not exist in the model but pits cannot be added to existing strings.

See also

12d to spreadsheet transfers
Spreadsheet to 12d update and create
Spreadsheet options

24.1 12d to spreadsheet transfers

This interface is accessed the Import/Export button on the Drainage Network Editor.

1. Select Spreadsheet clipboard
2. Leave as clipboard.txt to send the data to the windows clipboard as well as this file.
3. Mapping files are the most current 12d technology. Leave this selected.
4. Usually leave this off! Select to export the junction pit at the end of all drainage lines (very rarely needed).
5. You may also select to limit the output if desired. If you like using spreadsheets for data entry, the PCdrain data and ILSAX data formats are useful for adding data for the first time for either program.
6. Select Run to place the data on the clipboard.
25. Long Section Plotting

Detailed description of the 12d drainage long section plotting may be found in the 12d Reference manual. The long section plots are customised using the drainage plot parameter files (drainppf). Title blocks, user defined text may be added and then plotted directly or to various file formats (dwg, dgn etc.). From the main menu

Design=>Drainage-Sewer=>Plots=>Longsections

See Also

Set Pit Details to set road chainage and name data

1. To access the drainppf files supplied select the icon and then walk right on Lib to select this drainppf file.
2. Select Read
3. Enter a new name for this drawing
4. select Write.
   This will save the setting we are about to make should you want to replot this long section.
5. This section view determines the additional models (such as services) to show plot. These are referred to as corridor models. The vertical exaggeration is also obtained from this view.

6. The network model field will be completed with the model of the string being profiled. If this is not your drainage network model then select it now.
7. When Plotter Type is set to model then plot file stem is the model name prefix for plots that will be created. The first sheet of plots will be in model plot1, the second in plot2 etc.
8. Select + on the **Plot sheet layout branch** and then select **Other parameters**.

9. **The plot height** determines how much room is left vertically for the actual plot. This specifies the total height of the plot. 12d then constructs the box area and arrow area on the bottom and then arrow area on the top. The amount left over is used for the long section itself.

To stop datum breaks from occurring increase this height, increase your plot scale or decrease your vertical exaggeration. If there is too much white space in the graph area then reduce this value.
10. The **Drainage plot** + **title block** + **User title info** allow you to enter the text for the title block.

11. The list displayed is retrieve from the **title file** selected above. Enter the data for the plot.

12. Select **Write** to save the changed to the local drainppf file you entered earlier.

13. Select **Plot** and the plots will be send to the **plot file stem** entered. These models may be added (one at a time) to a plan view to inspect them before plotting to paper or exporting to other drawing packages.
26. More Information

This section provides detailed description of items introduced previously in the training notes.

26.1 Linking to Strings in General

Many pit properties may be calculated from strings linked to the pit. The following rules apply to all strings linked via the DNE.

1. The selection of strings is limited to the models specified on the DNE->Utility Model tab.
2. When no link exists for the pit, the closest string matching the selection criteria will be chosen. If a link exists, then no new string will be searched for. Even if the search criteria changes or a closer string is created. The link must be deleted before new links are searched for.
3. The link will not be broken unless another string is manually selected
   the link is manually Cleared with the RB on the manual string select
   the string is deleted (manually or when a recal is done on template applies),
   the model links are reset on the DNE->Utility Model tab,
   the model is removed from the DNE->Utility Model tab.
4. Once link is broken the calculated values will be kept unchanged, with the exception of bypass pits.

26.2 Catchment string links

Each catchment set has its own model of catchment strings and the sets are linked independently.

If the area (in ha) is present in the area field, no new string link be searched for.

Vertex number 1 on the catchment string determines which pit the string will link to. If vertex 1 of several catchment strings are closest to the same pit. Only the closest string will link and the remaining will not be used for any other pit.

After the catchment string link is created, the vertices are re arranged so that the vertex closest to the pit becomes vertex.

26.3 Road string links

Road strings have a name and maximum search distance criteria and there is no limit to how many pits link to a single road string. The closest string matching the string name criteria (in the road string file) and within the search distance will be selected. Note that once the string link is established, changing the criteria will NOT break the link.

26.4 Bypass string links

Pits marked with an Inlet type of Manhole on the DNE->Pit->Main tab ignore the bypass strings. Bypass strings must pass within 1 manhole diameter to be linked..
### 27. Training Check List

<table>
<thead>
<tr>
<th>Category</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network plan</td>
<td>- convert from strings</td>
</tr>
<tr>
<td></td>
<td>- insert, append, delete and move pits</td>
</tr>
<tr>
<td>Network Vertical</td>
<td>- Set Pit Details and Regrade pipes</td>
</tr>
<tr>
<td></td>
<td>- Pipe alignment modes</td>
</tr>
<tr>
<td>Set Pit Names</td>
<td></td>
</tr>
<tr>
<td>Catchments</td>
<td>- draw, label, link and check</td>
</tr>
<tr>
<td></td>
<td>- tc strings</td>
</tr>
<tr>
<td>Hydrology</td>
<td>- Area, Tc, C values with defaults</td>
</tr>
<tr>
<td>Hydraulics</td>
<td>- setout to grate</td>
</tr>
<tr>
<td></td>
<td>- method (pipe full or HGL)</td>
</tr>
<tr>
<td></td>
<td>- available pipe sizes and box culverts</td>
</tr>
<tr>
<td>Services</td>
<td>- over and under drainage pipes</td>
</tr>
<tr>
<td>Road strings</td>
<td>- rotate symbols</td>
</tr>
<tr>
<td></td>
<td>- x,y and/or z for setout</td>
</tr>
<tr>
<td></td>
<td>- road grade and crossfall for inlet capacity</td>
</tr>
<tr>
<td></td>
<td>- road chainage from centre line</td>
</tr>
<tr>
<td>12d design engine</td>
<td>understanding the reports</td>
</tr>
<tr>
<td>Setout pit schedules</td>
<td>- easting, northing and road centre line</td>
</tr>
<tr>
<td>Drawings</td>
<td>Long Section plotting</td>
</tr>
<tr>
<td></td>
<td>Plan drawings</td>
</tr>
<tr>
<td>Kerb Strings</td>
<td>- select by name</td>
</tr>
<tr>
<td></td>
<td>- crests and sags</td>
</tr>
</tbody>
</table>

THE END